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DIALOGS AND ALERTS
Includes Demonstration Program DialogsAndAlertsPascal

Introduction

Alerts and Alert Boxes

Alerts, which may be an alert sound or an alert box or both, warn the user whenever an unusual or
potentially undesirable situation occurs within your application.  An alert box, unlike a dialog box,
typically requires only the user's acknowledgment in order for your application to proceed.

Dialog Boxes

Dialog boxes allow the user to provide additional information or to modify settings before your
application carries out a command.

Because it greatly simplifies the task, the Dialog Manager should be used to implement alerts and
simple dialog boxes.  However, it is sometimes desirable to bypass the Dialog Manager and use
Window Manager, Control Manager, QuickDraw, and Event Manager routines to create and manage
complex dialog boxes.  Some situations which tend to diminish the advantages of using the Dialog
Manager are:

• The dialog box contains more than 20 items.

• You need a multi-part control, such as a scroll bar.

• You need to display a moving indicator, such as a progress indicator.

• You need to display a list in the dialog box.  (See Chapter 18 — Lists and Custom List Definition
Functions .)

• You need to display text in a font other than the system font.

• Your application must respond to events other than mouse-down events, key-down events
inside editable text items, and a limited number of keyboard equivalent key-down events.

The two issues to consider in relation to the creation and management of dialog boxes are therefore:

• Whether to use the Window Manager and Control Manager, instead of the Dialog Manager, to
create the dialog box.

• Whether to use the Event Manager, Window Manager, Control Manager, and TextEdit, instead
of the Dialog Manager, to handle events.
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In addressing these issues, you should also bear in mind that a hybrid approach, in which the Dialog
Manager is used to create, but not manage, a dialog box, is also possible.

Types of Alerts, Alert Boxes, and Dialog Boxes

Types of Alerts

When an alert condition occurs, and depending on the nature of that condition, your application can
simply play an alert sound or it can display an alert box.  Your application can also base its response on
the number of consecutive times the condition occurs, possibly playing an alert sound at first and
subsequently displaying an alert box.

Alert Sound

The system alert sound is a sound resource stored in the System file.  It is played whenever the
system software or your application uses the Sound Manager routine SysBeep.  The alert sound should
be used for errors which are minor and immediately obvious, such as attempting to backspace past the
left boundary of a text field.

Alert Boxes

There are three standard types of alert boxes, all of which are illustrated at Fig 1:

• Note Alert.  The note alert is used to inform users of an occurrence which will not have
disastrous consequences.  Usually, a note alert simply offers information.  Sometimes, as shown
at Fig 1, a note alert may ask a simple question and provide a choice of responses.

• Caution Alert.  The caution alert is used to alert the user to an operation which may have
undesirable results if it is allowed to continue.  As shown at Fig 1, you should provide the user,
via the buttons, with a choice of whether to continue or stop the action.

NOTE ALERT

CAUTION ALERT

STOP ALERT

FIG 1 - TYPES OF ALERTS
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• Stop Alert.   The stop alert is used to inform the user that a problem or situation is so serious
that the action cannot be completed.  As shown at Fig 1, stop alerts typically have only an OK
button.

The icons in the examples at Fig 1 are supplied automatically by the system.

Custom Alert Boxes

You can also create custom alert boxes, which might contain your own icons (or, possibly, no icons).
Custom alert boxes are typically used for About… boxes.

Types Of Dialogs Boxes

There are three types of dialog boxes, all of which are illustrated in the examples at Fig 2:

FIG 2 - TYPES OF DIALOG BOXES

MODAL DIALOG BOX

MOVABLE MODAL DIALOG BOX

MODELESS DIALOG BOX

Modal Dialog Boxes

Fixed-position modal dialog boxes place the user in the state, or mode, of being able to work only
inside the dialog box.  The only response the user receives when clicking outside the dialog box is the
alert sound.  This type of dialog box looks like an alert box except that it may contain other types of
controls in addition to buttons.

Movable Modal Dialog Boxes

Movable modal dialog boxes retain the modal characteristic of their fixed-position counterparts, the
main difference being the addition of a title bar which enables the user to drag the dialog box so as to
uncover obscured areas of an underlying window.  The other difference is that this type of dialog
allows the user to bring another application to the front by clicking in one of the application's windows
or by choosing the application's name from the Application menu.
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The absence of close boxes and zoom boxes in the title bar visually suggests to the user that the dialog
box is modal.

Modeless Dialog Boxes

Modeless dialog boxes look like document windows and do not require the user to respond before
doing anything else.  The user should be able to move the dialog box, activate and deactivate it, and
close it like any document window; however, unlike document windows, the box should contain no
scroll bars and no size box.

When you display a modeless dialog box, your application must allow the user to perform other
operations without first dismissing the dialog.  When the user clicks a button in the dialog box, the
application should not remove the dialog; it should only be removed by a click in the close box or when
the user selects Quit from the File menu.

Because of the difficulty of revoking the last action invoked from a modeless dialog box, it typically
does not have a Cancel button, although it may have a Stop button to halt long operations such as
searching and printing.

Items in Alert and Dialog Boxes

You use resources called item lists to specify the items to appear in alert boxes and dialog boxes.
Alert boxes should usually contain only informative text, button controls and perhaps a graphic (that
is, an icon or QuickDraw picture).  Dialog boxes may contain the following items:

• Informative or instructional text.

• Rectangles in which text may be entered (that is, editable text items).

• Controls.

• Graphics (that is, icons or QuickDraw pictures).

• Other items as defined by your application (for example, status bars).

Enabled and Disabled Items

Items may be enabled or disabled.  An enabled item is one for which the Dialog Manager reports user-
initiated events.  A disabled item is one for which the Dialog Manager does not report events.  Your
application can enable and disable any item.

Note that a disabled item is not the same as an inactive control.  The distinction is as follows:

• Disabled Item. When you do not want the Dialog Manager to report clicks in a control, you
disable the item.  Note that the Dialog Manager makes no visual distinction between a disabled
item and an enabled item.

• Inactive Control.  When you do not want the Control Manager to respond to clicks in a
control, you make it inactive with the Control Manager routine HiliteControl.  The Control
Manager displays an inactive control in a way which indicates that it is not active (that is, by
dimming it).

Default Buttons in Alert Boxes

To assist the user who is not sure how to respond when an alert appears, your application specifies a
default button for every alert box.  In alert boxes, the Dialog Manager draws a bold outline around
this button.  If the user presses the Return key or the Enter key, the Dialog Manager acts as if the user
had clicked the default button.
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Default Buttons in Dialog Boxes

Dialog boxes typically contain an OK button and a Cancel button, although the OK button may
sometimes contain a title reflecting the action to be performed.  The default button requirement (that is,
the response to the Return and Enter key) also applies to dialog boxes.

Unless you provide your own event filter function (see below), the Dialog Manager treats the first
button item in the dialog as the default button.  Note, however, that the Dialog Manager does not draw
a bold outline around the default button in dialog boxes.

Removal of Alert and Dialog Boxes

The Dialog Manager automatically removes an alert box when the user clicks any enabled item.

Your application should remove a modal or movable modal dialog box only after the user clicks one of
its enabled buttons.

Your application should not remove a modeless dialog box unless the user clicks its close box or
chooses Close from the File menu when the modeless dialog box is the active window.

Creating Alerts

Alert, NoteAlert, CautionAlert and StopAlert are used to create alerts.  Icons associated with the latter
three automatically appear in the upper-left corner of the alert boxes.  The Alert function allows you to
display no icon or your own icon.  When the user clicks a button in the alert box, the functions return
the button's item number and close the alert box.

Alert, NoteAlert, CautionAlert and StopAlert take descriptive information about the alert from an
'ALRT' resource.  The ID of this resource is passed in the function's first parameter.

The 'ALRT'  Resource

The 'ALRT' resource ID is the first parameter in the Alert, NoteAlert, CautionAlert and StopAlert call.
A typical 'ALRT' resource, in Rez input format, is as follows:

resource 'ALRT' (kSaveAlertID, purgeable)
{

{94,80,183,438},/* Rectangle for alert box. */
kAlertItemList, /* Resource ID for item list ('DITL') resource. */
{ /* ALERT STAGES:

OK, visible, sound1, /* 4th alert stage. */
OK, visible, sound1, /* 3rd alert stage. */
OK, visible, sound1, /* 2nd alert stage. */
OK, visible, sound1, /* 1st alert stage. */

},
alertPositionParentWindow /* Positioning constant. */

};

Alert Stages

When an alert condition occurs, your application can base its response on the number of times that
condition has occurred.  In the example 'ALRT' resource definition above, the listing specifies that each
consecutive time the user repeats the action which invokes the alert, the Dialog Manager should outline
the OK button and treat it as the default button, display the alert box and play a single system alert
sound.

You can, however, define different responses for each of the four alert stages.  This is most appropriate
for stop alerts — that is, those which signify that an action cannot be completed, especially when that
action has a high probability of being accidental.  In such circumstances, your application might simply
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play the alert sound the first two times the user makes the mistake and, subsequently, display the alert
box as well.  Note that every occurrence of the mistake after the fourth is treated as a fourth stage alert.

Specifying invisible in the alert stages section of the resource definition causes the alert box not to be
displayed.  Specifying sound2 or sound3 causes the system alert sound to be played twice and three
times respectively.1 2

Positioning Constant

If a positioning constant is not provided, the Dialog Manager places the alert box at the global
coordinates you specify for the alert's rectangle.

Event Filter Function

The second parameter in Alert, NoteAlert, CautionAlert and StopAlert calls is a pointer to an event
filter function.  Specifying nil for the event filter function parameter causes the functions to use the
standard event filter function, which provides for users pressing the Return or Enter keys in lieu of
clicking on the default button.

The standard event filter function, however, has some basic limitations.  The main limitation is that it
does not permit background applications to receive or respond to update events.  For that reason, your
application should provide a replacement event filter function (see below) which, in addition to
allowing users to press the Return or Enter keys in lieu of clicking on the default button, and as a
minimum, allows background applications to receive null events.

Window Definition ID

When you create an alert box, the Dialog Manager always passes to the Window Manager the window
definition ID represented by the constant dBoxProc.3

Creating Dialog Boxes

GetNewDialog or NewDialog are used to create dialog boxes.  GetNewDialog is usually used, since it takes
information about the dialog box from a 'DLOG' resource.  GetNewDialog creates a dialog record from
the information in the 'DLOG' resource and returns a pointer to that record.

If NULL is specified as the second parameter in the GetNewDialog call, GetNewDialog itself creates a non-
relocatable block for the dialog record.  Passing NULL is appropriate for modal and movable modal
dialog boxes; however, in order to avoid heap fragmentation effects, you should ordinarily allocate
your own memory for modeless dialog box dialog records (just as you would for a window record) and
specify the pointer to that memory block in the second parameter to the GetNewDialog call.4

The Dialog Record

The dialog record created by the  GetNewDialog call is defined by the data type DialogRecord:

type
DialogRecord = record

window: WindowRecord;
items: Handle;
textH: TEHandle;
editField: integer;
editOpen: integer;
aDefItem: integer;

                                                
1If the user has set the speaker volume to 0, the menu bar blinks once in place of each sound.
2If you want the Dialog Manager to play sounds other than the system sound, you must write your own sound procedure and then call
ErrorSound, passing it a pointer to your sound procedure.  This makes your sound procedure the current sound procedure.
3The Window Manager always displays an alert box in front of all other windows.
4However, see Footnote 8 at Chapter 4 — Widows.
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end;

DialogPeek = ^DialogRecord;

Note that the dialog record includes a window record field.  The Dialog Manager sets the windowKind
field of this window record to dialogKind.

The 'DLOG'  Resource

An example of a 'DLOG' resource, in Rez input format, is as follows:

resource 'DLOG' (kSpellCheckID, purgeable)
{

{62,184,216,448}, /* Rectangle for dialog box. */
dBoxProc, /* Window definition ID for modal dialog box. */
visible, /* Display this dialog box immediately. */
noGoAway, /* No go away box. (Use goAway for modeless dialog box.) */
0x0, /* Initial reference constant is 0. */
kSpellCheckDITL, /* Item list ('DITL') resource ID */
"SpellCheck Options", /* Title, (Use empty string for modal dialogs.) */
alertPositionParentWindow /* Positioning constant. */

};

Window Definition ID.  In this example, the window definition ID represented by the constant
dBoxProc is specified, meaning that the resource is for a modal dialog box.  The window definition IDs
you use for dialog boxes are as follows:

Type of Dialog Box Window definition
ID

Modal dialog box dBoxProc

Movable modal dialog box movableDBoxProc

Modeless dialog box noGrowDocProc

Visible/Invisible.  The visible constant specifies that the dialog box will be displayed immediately.
If invisible is specified, a call to  ShowWindow is required to display the dialog box when required.

Reference Constant.  The 0x0 specified as the reference constant is simply a filler.  You may wish to
store a number which represents the dialog box type, or perhaps a handle to a record which maintains
state information about the dialog box.

Positioning Constant.  Other options for the positioning constant are alertPositionParentScreen
and alertPositionParentWindowScreen.

Items for Alerts and Dialog Boxes

The 'DITL'  Resource

You use an item list ('DITL') resource to store information about all the items in an alert or dialog
box.  The 'DITL' resource ID is specified in the associated 'ALRT' or 'DLOG' resource.

Within a 'DITL' resource for an alert box you can specify static text, buttons, icons and QuickDraw
pictures.  In dialog boxes, checkboxes, buttons, editable text and controls may be added.

An example of a 'DITL' resource, in Rez input format, is as follows:

resource 'DITL' (kAboutBoxDITL, purgeable) /* Items for About… alert box */
{

/* ITEM NO 1 */
{ {86,201,106,259}, /* Display rectangle for item (Local to the dialog box.) */

Button     { /* Item is a button. */
enabled, /* Enable item. (Return clicks.) */
"OK" /* Title for button */

},
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/* ITEM NO 2 */
{10,20,42,52}, /* Display rectangle for item. */
Icon       { /* Item is an icon. */

disabled, /* Disable item.  (Do not return clicks.) */
kAboutIconID /* 'ICON' or 'cicn' resource ID. */

},
/* ITEM NO 3 */

{10,78,74,259}, /* Display rectangle for item. */
StaticText { /* Item is static text */

disabled, /* Disable item.  (Do not return clicks.) */
"My Application\n" /* Text string to display */
"Version 1.0"

},
/* ITEM NO 4 */

{0,0,0,0}, /* (Help items get an empty rectangle.) */
HelpItem   { /* Invisible item for reading in help balloons. */

disabled, /* Disable item.  (Do not return clicks.) */
HMScanhdlg /* Scan resource type 'hdlg' for help balloons. */
{kAboutBoxHelp} /* Get 'hdlg' resource with this resource ID. */

}
}

};

Note that, as in this example, 'DITL' resources should invariably be marked as purgeable.

Items are usually referred to by their position in the item list, that is, by their item number.  In the
example, the Dialog Manager would return 1 when the user clicked in the OK button.

As previously stated, GetNewDialog creates a dialog record.  It then reads in the 'DITL' resource and
stores a handle to it in the dialog record.  Because the Dialog Manager always makes a copy of the
'DITL' resource and uses that copy, several independent dialog boxes may use the same 'DITL'
resource.  AppendDITL and ShortenDITL may be used to modify or customise copies of a shared item list
resource for use in individual dialog boxes.

Display Rectangles

The display rectangle determines the location of an item within an alert box or dialog box.

Controls.  For controls, the display rectangle becomes the control's enclosing rectangle.  To match a
control's enclosing rectangle to its display rectangle, specify an enclosing rectangle in the 'CNTL'
resource which is identical to the display rectangle specified in the 'DITL' resource.5

Editable Text Items.  For an editable text item, the display rectangle becomes the TextEdit
destination rectangle and view rectangle (see Chapter 17 — Text and TextEdit).  Word wrapping
occurs within display rectangles that are large enough to contain multiple lines of text, and the text is
clipped if there is more text than will fit in the rectangle.  The Dialog Manager draws a rectangle three
pixels outside the display rectangle.

Static Text Items.  For a static text item, the Dialog manager draws the text within the display
rectangle just as it draws editable text items, except that the framed rectangle is not drawn.

Icons and QuickDraw Pictures.  For an icon or QuickDraw picture larger than the display
rectangle, the Dialog Manager scales the icon or picture to fit the display rectangle.

A click anywhere in the display rectangle is considered a click in that item.  If display rectangles
overlap, a click in the overlapping area is considered a click in whichever item appears first in the item
list resource.

Conventions for Positioning Button and
Text Display Rectangles

Recommended locations for buttons and text in an alert box are illustrated at Fig 3.

                                                
5When an item is a control defined in a control resource, the rectangle added to the update region is the rectangle defined in the 'CNTL'
resource, not the display rectangle specified in the 'DITL' resource.
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FIG 3 - CONSISTENT SPACING OF BUTTONS AND TEXT IN AN ALERT BOX

Be aware that the Window Manager adds three white pixels inside the window frame when it draws
alert boxes and modal dialog boxes.  Therefore, specify display rectangle locations as follows when you
use tools like Rez and ResEdit:

• Place the lower-right button 10 pixels from the right edge and 10 pixels from the bottom edge of
the alert or modal dialog box.  Align the display rectangles for other bottom-most and right-most
items with this button.

• Place the upper-left icon 10 pixels from the top edge and 20 pixels from the left of the alert or
modal dialog box.  Align the display rectangles for the other top-most and left-most items with
this item.  (The Dialog Manager automatically places the note, caution and stop icons in this
position.)

• Place other elements 13 or 23 pixels apart, as shown at Fig 3.

Item Types

The example 'DITL' resource contains four item types.  The following shows the full range of item
types you can include in alert and dialog boxes :

Constant Description
StaticText Static text, that is, text that cannot be edited.
Button Button control.
Icon Icon whose black and white resource is stored in an 'ICON' resource and whose colour

version is stored in a 'cicn' resource with the same ID as the 'ICON' resource.
Picture QuickDraw picture stored in a 'PICT' resource.
HelpItem Invisible item which makes the Help Manager associate help balloons with the other

items defined in the item list resource.
RadioButton Radio button control. (Use in dialog boxes only.)
CheckBox Check box control. (Use in dialog boxes only.)
Control Control defined in a 'CNTL' resource. (Use in dialog boxes only.)
EditText Editable text item. (Use in dialog boxes only.)
UserItem Application-defined item. (Use in dialog boxes only.)

Note that static and editable text is drawn, by default, using the system font; however, the font used to
draw this text can be changed using SetDialogFont.

Default Buttons

Default Button in Alert Boxes

The first item in an alert box's item list should always be the OK button.  If a Cancel button is necessary,
it should be the second item.
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Default Button in Dialog Boxes

As previously stated, the Dialog Manager does not automatically draw a bold outline around the
default button for dialog boxes.  You should normally give every dialog a default button.6  If you do
not provide your own event filter function, the Dialog Manager treats the first item in the item list
resource as the default button.

Enabling and Disabling Items

Generally, you should enable controls only.  You typically disable icons, pictures and static text items
because there is no requirement to receive reports of mouse-down events in these items.

Editable text items are normally disabled because an editable text item is not a control and your
application does not need to respond to clicks in the item.

Editable Text Items

Editable text items accept input from the keyboard.  The Dialog Manager automatically displays the
insertion point caret in an editable text item to indicate that it is accepting keyboard input.  If you do
not want to display default text in an editable text item, specify an empty string as the item's final
element in the 'DITL' resource.  Specify a string if you want to display default text.7

The Dialog Manager handles mouse-down and Tab key-down events.  If an alert or dialog box contains
more than one editable text item, this enables the user to select any item by either clicking the desired
item or pressing the Tab key to cycle through the available items in the sequence determined by their
position in the item list.  You should therefore ensure that the item numbers of editable text items in
your 'DITL' resource reflect the sequence in which you require them to be selected by successive Tab
key presses.

Manipulating Items

Routines for Manipulating Items

Dialog Manager routines8 for manipulating items are as follows:

Routine Description
AppendDITL Adds items to a dialog box.
ShortenDITL Removes items from a dialog box.
GetDialogItem Returns the item type, the display rectangle, and the control handle or application-

defined function of a given item in a dialog box.
SetDialogItem Sets the item type and the display rectangle of an item or, for application-defined

items, the draw function of an item.
GetAlertStage Returns the stage of the last occurrence of an alert.
ResetAlertStage Resets the stage of the last occurrence of an alert.
HideDialogItem Hides the given item.
ShowDialogItem Re-displays a hidden item.
GetDialogItemText Returns the text of an editable or static text item.
SelectDialogItemText Selects the text of an editable text item.
FindDialogItem Finds an item that contains a specified point within a dialog box.
CountDITL Counts items in a dialog box.
ParamText Substitutes up to four different text strings in static text items.

                                                
6However, do not display a bold outline around any button if you use the Return key in editable text items.
7You can use SelIText to indicate a selected text range within an editable text item.
8Note that there are alternative (older) spellings for some of these routines.
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Adding Items to an Existing Dialog Box

You can dynamically add items to, and remove items from, a dialog box by using AppendDITL and
ShortenDITL.  These routines are especially useful where several dialog boxes share the same 'DITL'
resource and you want to add or remove items as appropriate for individual dialog boxes.

When you call AppendDITL , you specify a new 'DITL' resource to append to the dialog box's existing
'DITL' resource.  You also specify where the Dialog Manager should display the new items by using
one of these constants in the AppendDITL call:

Constant Value Description
overlay 0 Overlay existing items.  Coordinates of the display rectangle are interpreted as

local coordinates within the dialog box.
AppendDITLRight 1 Append at right.  Display rectangles are interpreted as relative to the upper-

right coordinate of the dialog box.
appendDITLBottom 2 Append at bottom.  Display rectangles are interpreted as relative to the lower-

left coordinate of the dialog box.

As an alternative to passing these constants, you can pass a negative number to AppendDITL, which
appends the items relative to an existing item in the dialog box.  The absolute value of this number is
interpreted as the item in the dialog box relative to which the new items are to be positioned.  For
example, -2  would cause the display rectangles of the appended items to be offset from the upper-left
corner of item number 2 in the dialog box.

AppendDITL modifies the contents of the dialog box (for instance, by enlarging it).  To use the
unmodified version of the dialog box at a later time, you should call ReleaseResource to release the
memory occupied by the appended item list.

Getting Text From Editable Text Items

Getting text from an editable text item involves a call to GetDialogItem, which returns a handle to the
item, and passing this handle to GetDialogItemText.

Changing Static Text

ParamText may be used to change static text in an alert box or dialog box.  A common example is the
inclusion of the window title in static text such as "Save changes to the document ... before closing?".
In this case, the window's title could be retrieved using GetWTitle and inserted by ParamText at the
appropriate text replacement variable (^0 , ^1 , ^2 or ^3 ) specified in the text string field of the static text
item in the 'DITL' resource.  (Since there are four text replacement variables, ParamText can supply up
to four text strings for a single alert or dialog box.)

Using an Application-Defined Item to Draw a Default Button's Bold Outline

You can include your own type of application-defined item  in a dialog box (for example, a clock).
One use of an application-defined item is to draw a bold outline around the default button in a dialog
box.  To define this item, include an item of type userItem in your 'DITL' resource.  It should have a
display rectangle but no text and no resource ID associated with it.  The following example shows part
of a 'DITL'  resource containing the item:

resource 'DITL' (kSpellCheckDITL, purgeable)
{

{
/* ITEM NO 1 - OK button (default). */
{123,170,144,254}, Button {enabled, "OK"},
...
/* ITEM NO 6 - Application-defined item */
{115,164,152,260}, UserItem {disabled,}

}
}

Note that the application-defined item is disabled because the OK button, which should lay within the
application-defined item, is itself enabled.
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You must then provide a routine which draws your application-defined item.  Your draw routine must
have two parameters: a dialog pointer and an item number from the dialog box's 'DITL' resource.  The
routine is installed using GetDialogItem and SetDialogItem .  GetDialogItem is used to get the handle
to the application-defined item specified in the 'DITL' resource.  SetDialogItem is then used to replace
this handle with a pointer to your draw routine.

When calling your draw routine, the Dialog Manager sets the current port to the dialog box's graphics
port.  The Dialog Manager then calls your routine to draw the application-defined whenever the Dialog
Manager receives an update event for the dialog box.

It is best if the associated 'DLOG' resource specifies the invisible constant, making the dialog box
invisible while you install the draw routine for the specified item.  ShowWindow may then be called to
display the dialog box.

Displaying Alert and Dialog Boxes

As previously stated, Alert, NoteAlert, CautionAlert and StopAlert are used to display alert boxes,
GetNewDialog displays those dialog boxes that you specify as visible in their 'DLOG' resources, and you
must use ShowWindow following the GetNewDialog call to display dialog boxes that you specify as
invisible in their 'DLOG'  resources.  You should invariably specify (WindowPtr) -1 as a parameter to
GetNewDialog so as to display a dialog box as the active (frontmost) window.

You should perform the following tasks in conjunction with displaying an alert box or dialog box.

• Deactivate the frontmost window (if one exists).

• If you are displaying a modeless dialog box, determine whether you have previously invoked it.
If so, use ShowWindow to make it visible and SelectWindow to make it active.

• Adjust your menus appropriately for a modal dialog box with editable text items and for any
movable modal and modeless dialog you wish to display.

Deactivating Windows Behind Alert and Dialog Boxes

Movable Modal and Modeless Dialog Boxes

You do not have to deactivate the front window explicitly when displaying movable modal and
modeless dialog boxes.  The Event Manager continues sending your application activate events for
your windows as needed, which you typically handle in your main event loop.

Alert and Modal Dialog Boxes

On the other hand, ModalDialog, which initiates the session of user interaction with alert and modal
dialog boxes, traps all events before they are passed to your event loop (which, of course, ordinarily
handles activate events for your windows).  Thus, if a window is active, you must explicitly deactivate it
before displaying an alert or modal dialog box.

If your application does not display an alert box during certain alert stages, use the GetAlrtStage
function to test for those stages before deactivating the active window.

Adjusting Menus for Alert and Modal Dialog Boxes

The Dialog Manager and Menu Manager interact to provide varying degrees of access to the menus in
your menu bar.  When your application displays an alert box or modal dialog box (that is, a window of
type dBoxProc), system software disables all items in the Application and Help menus except the Show
Balloons/Hide Balloons command in the Help menu.

When your application displays an alert box or calls ModalDialog to display a modal dialog box, the
Dialog Manager determines whether any of the following cases is true:
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• Your application does not have an Apple menu.

• Your application does have an Apple menu, but the menu is currently disabled.

• Your application has an Apple menu, but the first item in that menu is currently disabled.

If none of these cases is true, system software behaves as follows:

• The Menu Manager disables all your application's menus.

• If the modal dialog box contains a visible and active editable text field, and if the menu bar
contains a menu having commands with the standard keyboard equivalents for Cut, Copy and
Paste, the Menu Manager enables those three commands and the menu which contains them.

Alert Boxes and Modal Dialog Boxes
Without Editable Text Items

When your application displays alert boxes and modal dialog boxes with no editable text items, it can
safely allow system software to handle menu bar access.

Modal Dialog Boxes with Editable Text Items

However, because system software cannot handle the Undo and Clear commands (or any other context-
dependent command), your application should handle its own menu bar access for modal dialog boxes
with editable text items by performing the following tasks:

• Disable the Apple menu or its first item (typically, the About… command) in order to take
control of menu bar access away from the Dialog Manager.

• Disable all of the application's menus except the Edit menu, as well as any inappropriate
commands in the Edit menu.

• Use DialogCut, DialogCopy, DialogPaste, and DialogDelete to support the Cut, Copy, Paste, and
Clear commands in editable text items.9

• Provide your own code for supporting the Undo command.

• Enable your application's items in the Help menu as appropriate.

Restoring Menus

When the user dismisses the alert box or modal dialog box, the Menu Manager restores all menus to
their previous state unless your application handles its own menu bar access, in which case your
application must restore the menu bar to its previous state.

Adjusting Menus for Movable Modal and Modeless Dialog Boxes

Although it always leaves the Help and Application menus and their items enabled, system software
does nothing else to help manage the menu bar when you display movable modal and modeless dialog
boxes.  Instead, your application should allow or deny access to the rest of your menus as appropriate
to the context.

Movable Modal Dialog Box

When creating a movable modal dialog box, your application should perform the following tasks:

• Leave the Apple menu open so that the user can open other applications with it.

                                                
9Your application can test whether a dialog box is the front window when handling mouse down events and call these routines as
appropriate.
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• If your movable modal dialog box contains editable text items, use the Dialog Manager routines
DialogCut, DialogCopy, DialogPaste and DialogDelete to support the Cut, Copy, Paste, and
Clear commands in editable text items.

• Disable all of your other menus.

Modeless Dialog Boxes

When creating a modeless dialog box, your application should perform the following tasks:

• Disable only those menus whose commands are invalid in the current context.

• If the modeless dialog box includes editable text items, use the Dialog Manager routines
DialogCut, DialogCopy, DialogPaste and DialogDelete to support the Cut, Copy, Paste, and
Clear commands in editable text items.

Displaying Multiple Alert and Dialog Boxes

The user should never see more than one modal dialog box and one alert box on the screen
simultaneously.  However, you can present multiple simultaneous modeless dialog boxes just as you
can present multiple document windows.

The Window Manager automatically dims the frame of a dialog box when you deactivate it to display
an alert box, another modal dialog box or a window.  When you deactivate a dialog box, you should
use HiliteControl to make the controls of the dialog inactive.  You should also draw the outline of the
default button in grey instead of black.

Displaying Alert and Dialog Boxes from the Background

If you ever need to display an alert box or a modal dialog box while your application is running in the
background or is otherwise invisible to the user, you should use the Notification Manager to post a
notification to the user.  The Notification Manager automatically displays an alert box containing
whatever message you specify; you do not need to use the Dialog Manager to create the alert yourself.
(See Chapter 22 — Miscellany for a description of the Notification Manager).

Including Colour

On colour monitors, the Dialog Manager automatically adds the system default colours to the frame
and title bar of your alert and dialogs boxes so that they match the colours of the windows, alert boxes
and dialog boxes used by the system software.  Colour in the content region is, however, another
matter.

Alert and dialog boxes are created with a black-and-white graphics port.  However, you can force the
Dialog Manager to create alert and dialog boxes with a colour graphics port by providing a dialog
color table resource  ('dctb') with the same resource ID as the alert or dialog resource.

There are two specific circumstances where you will want to ensure that the dialog box is created with
a colour graphics port:

• When you want to produce a blended grey colour for outlining the default button when it is
inactive (that is, dimmed).  Unless a blended grey colour is used to draw the dimmed default
button outline, the only alternative is to set the drawing pen pattern to the QuickDraw variable
gray.  gray represents a black-and-white pattern, not a colour.  For aesthetic reasons, this is not
appropriate on a colour or grey scale display.

• When you want to display a colour icon or picture in the dialog box (or alert box), and have the
icon or picture appear in colour, rather than black-and-white, in a system software environment
earlier than version 7.1 as updated by System Update 3.0.
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When you create a 'dctb' resource, you should not change the system's default colours.  The following
is an example of a dialog colour table resource which leaves the default colours intact but forces the
Dialog Manager to supply a colour graphics port:

data 'dctb' (kGlobalChangesDialog, purgeable)
{

$"0000 0000 0000 FFFF"/* Use default colours */
};

Handling Events in Alert and Dialog Boxes

Overview

Alert and Modal Dialog Boxes

When Alert, NoteAlert, CautionAlert, and StopAlert are used to display alerts, the Dialog Manager
handles all of the events generated by the user until the user clicks a button.  When the user clicks a
button, the functions invert the button, close the alert box and report the user's selection to the
application.

The Dialog Manager routine ModalDialog initiates a session of user interaction with a modal dialog and
handles most of that interaction until the user selects an item.  ModalDialog  then reports that the user
selected an enabled item, and your application is then responsible for performing the action associated
with that item.  Your application typically calls ModalDialog repeatedly until the user clicks on the OK
or Cancel button.

Event Filter Function.  As previously stated, you should supply an event filter function for Alert
boxes so as to avoid the basic limitations of the standard event filter function.  This requirement also
applies to modal dialog boxes.  You can supply an event filter function as one of the parameters to
Alert, NoteAlert, CautionAlert, StopAlert, and ModalDialog.  If you supply an event filter function,
these routines will pass events to your event filter function before handling each event.  In this way,
your event filter function can handle any event not handled by the Dialog Manager.

Movable Modal and Modeless Dialog Boxes

For movable modal and modeless dialog boxes, two alternatives are available to handle events:

• Determine whether an event occurred while the dialog box was the frontmost window, perhaps
using IsDialogEvent for that purpose.10  If the dialog box was the frontmost window, use
DialogSelect to:

• Handle key-down events in editable text items automatically.

• Handle update and activate events automatically.

• Report the enabled items that the user clicks.11

Then respond appropriately to clicks in your active items.

• Handle events in modeless and movable modal dialog boxes much as you handle events in other
windows.

Responding to Events in Controls

For clicks in checkboxes, pop-up menus and radio buttons, your application should use the Control
Manager routines GetControlValue and SetControlValue to get and set the item's value.  When the user

                                                
10For every type of event which occurs while the dialog box is active, IsDialogEvent returns TRUE.
11DialogSelect differs from ModalDialog in that it returns control after every event, not just events related to enabled items.
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clicks on the OK button, your application should perform whatever action is necessary according to the
values returned by each of the checkboxes and radio buttons.

Events and Editable Text Items

Editable text items are typically disabled because you generally do not need to be informed every time
the user clicks on one of them or types a character.  Instead, you simply need to retrieve the text when
the user clicks the OK button.

When you use ModalDialog or DialogSelect, the Dialog Manager calls TextEdit to automatically handle
keystrokes and mouse actions within editable text items so that:

• When the user clicks the item, a blinking vertical bar, called the caret, appears.

• When the user drags over text or double-clicks a word, that text is highlighted and replaced by
whatever the user types.

• When the user holds down the Shift key while clicking and dragging, the highlighted section is
extended or shortened appropriately.

• When the user presses the backspace key, the highlighted selection or the character preceding
the insertion point is deleted.

• When the user presses the Tab key, the cursor automatically advances to the next editable text
item (if any), wrapping around to the first one if there are no more items.

Caret Blinking

If your movable modal or modeless dialog box contains any editable text items, you should call
DialogSelect in your main event loop's idle processing function.  This is necessary because
DialogSelect calls TEIdle to make the caret blink within your editable text items when null events are
received.12

Edit Menu

The Edit menu should be left enabled and you should use DialogCut, DialogCopy, DialogPaste, and
DialogDelete to support the Cut, Copy, Paste, and Clear commands and their keyboard equivalents.
You should also provide your own code to support the Undo command.

Return Key, Enter Key, and the Default
Button Outline

If you do not supply an event filter function, and the user presses the Return or Enter key while the
modal dialog is on-screen, the Dialog Manager treats the event as a click on the default button
regardless of whether the dialog box contains an editable text item.  If you do supply an event filter
function and it responds to the user pressing Return or Enter by moving the cursor in editable text
items, do not display a bold outline around any buttons.

Responding to Events in Alert Boxes

After displaying an alert box or playing an alert sound, Alert, NoteAlert, CautionAlert, and StopAlert
call ModalDialog to handle events automatically.  ModalDialog, in turn, gets each event by calling
GetNextEvent.

If the event is a mouse-down outside the alert box's content region, ModalDialog emits the system alert
sound and gets the next event.

                                                
12You should also ensure that, when caret blinking is required, the sleep parameter in the WaitNextEvent call is set to a value no greater that
that returned by GetCaretTime.
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ModalDialog is continually called until the user selects an enabled control, at which time Alert,
NoteAlert, CautionAlert and StopAlert remove the alert box from the screen and return the item
number of the selected control.  Your application then should then respond appropriately.

The standard event filter function allows users to press the Return or Enter key in lieu of clicking the
default button.  When you write your own event filter function (see below), it should emulate the
standard filter function by responding to the keyboard in the same way.  For events inside the alert
box, ModalDialog passes the event to your event filter function before handling the event.  Your event
filter function thus provides a means to:

• Handle events which ModalDialog does not handle.

• Override events ModalDialog would otherwise handle.

Unless your event filter function handles the event in its own way and returns true, ModalDialog
handles the event inside the alert box as follows:

• In response to an activate or update event for the alert box, ModalDialog activates or updates its
window.

• If the user presses the mouse button while the cursor is in a control, TrackControl is called to
track the mouse.  If the user releases the mouse button while the cursor is still in the control, the
alert box is removed and the control's item number is returned.

• If the user presses the mouse button while the cursor is in any enabled item other than a control,
the alert box is removed and the item number is returned.

• If the user presses the mouse button while the cursor is in a disabled item, or if it is in no item, or
if any other event occurs, nothing happens.

Responding To Events in Modal Dialog Boxes

Your application should call ModalDialog immediately after displaying a modal dialog box.
ModalDialog repeatedly handles events inside the dialog box until an event involving an enabled item
occurs, at which time ModalDialog returns the item number.  Your application should then respond
appropriately to that item number.  Your application should continually call ModalDialog until the user
clicks on the OK or Cancel button, at which time your application should close the dialog box.

If the event is a mouse-down outside the content region, ModalDialog emits the alert sound and gets
the next event.

Unless your event filter function (see below) handles the event and returns true, ModalDialog handles
the event as follows:

• In response to an activate or update event for the dialog box, ModalDialog activates or updates
its window.

• If the user presses the mouse button while the cursor is in an editable text item, ModalDialog
responds to the mouse activity as appropriate, that is, by either displaying an insertion point
caret or by selecting text.  If a key-down event occurs and there is an editable text item, text
editing and entry are handled as previously described.  If the editable text item is enabled,
ModalDialog returns its item number after it receives either the mouse-down or key-down event.

• If the user presses the mouse button while the cursor is in a control, TrackControl is called.  If
the user releases the mouse button while the cursor is within an enabled control, ModalDialog
returns the control's item number.

• If the user presses the mouse button while the cursor is in any other enabled item, ModalDialog
returns the item number.  (Generally, only controls should be enabled.)



6-18 Dialogs and Alerts

• If the user presses the mouse button while the cursor is in a disabled item or no item, nothing
happens.

Event Filter Functions for Alert and Modal Dialog Boxes

In early versions of the system software, when a single application controlled the computer, the
standard event filter for alert and modal dialog boxes was usually sufficient.  However, because the
standard filter does not permit background applications to receive or respond to update events, it is no
longer adequate.  Your application should therefore provide a simple event filter function which
performs these functions and also allows inactive windows to receive update events.  In most cases,
you can use the same filter function for all of your alert boxes and modal dialog boxes.

You can also use your event filter to handle events that ModalDialog does not handle, such as a
Command-period key-down event, disk-inserted events, keyboard equivalents, and mouse-down
events for application-defined items.

At a minimum, your event filter should perform the following tasks:

• Return true, and the item number for the default button if the user presses the Return or Enter
key.

• Return true, and the item number for the Cancel button if the user presses the Esc key or the
Command-period combination.

• Update your windows in response to update events and return false. 13

• Return false for all events that your event filter does not handle.

Your event filter function should have three parameters and return a Boolean value:

eventFilter(theDialog : DialogPtr; var theEvent : EventRecord;
  var itemHit : integer) : boolean;

When your function returns false, ModalDialog handles the event.  If your function does handle the
event, it should return true and, in the itemHit parameter, the number of the item that it handled.
ModalDialog and, in turn, Alert, NoteAlert, CautionAlert, and StopAlert, then return this item
number in their own itemHit parameter.

Because ModalDialog calls GetNextEvent with a mask which excludes disk-inserted events, your event
filter function can call SetSystemEventMask to reset the mask to accept disk-inserted events if you wish
the filter function to handle disk-inserted events.

To give visual feedback indicating which item has been selected, your filter function should invert
buttons activated by keyboard equivalents.  A good rule of thumb is to invert a button for eight ticks.

As previously stated, if your modal dialog box contains editable text items, your application should
support the use of Edit menu items, in which case your filter function should test for, and handle,
mouse-down events in the menu bar and key-down events for keyboard equivalents.

Mouse Events in Movable Modal and Modeless Dialog Boxes

When your application detects that an event occurred while a movable modal or modeless dialog box
was the frontmost window, you should use DialogSelect to:

• Handle key-down events in editable text items automatically.

• Handle update and activate events automatically.

• Report the enabled items that the user clicks.

                                                
13This action also allows background applications to receive update events.
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You must then use other ToolBox routines to handle other types of events in the dialog box.  Your
application should be prepared to handle the following mouse events:

• Clicks in the menu bar, which your application has adjusted as appropriate for the dialog box.
(For Edit menu selections, you can use DialogCut, DialogCopy, DialogPaste, and DialogDelete to
support the Cut, Copy, Paste, and Clear commands in editable text items.)

• Clicks in the content region of an active movable modal or modeless dialog box.  You can use
DialogSelect to aid you in handling the event.

• Clicks in the content region of an inactive modeless dialog box.  In this case, your application
should make the modeless dialog active by making it the front window.

• Clicks in the content region of an inactive window whenever a movable modal or modeless
dialog box is active.  For movable modal dialog boxes, your application should emit the system
alert sound.  For modeless dialog boxes, your application should bring the inactive window to
the front.

• Mouse-down events in the title bar of an active movable modal or modeless dialog box.  Your
application should use DragWindow to move the dialog box in response to the user's actions.

• Mouse-down events in the title bar of an inactive window when a movable modal dialog box is
active.  Your application should not move the inactive window in response to the user's actions;
instead, your application should play the system alert sound.

• Clicks in the close box of a modeless dialog box.  Your application should dispose of, or hide, the
dialog box, whichever action is most appropriate.

Keyboard Events in Movable Modal and Modeless Dialog Boxes

When your application detects that a keyboard event occurred while a movable modal or modeless
dialog box was the frontmost window, your application should be prepared to handle the following
keyboard events:

• Keyboard equivalents applicable to the dialog box, such as Command-X to perform a cut in an
editable text item.

• Key-down events for the Return and Enter keys, to which your application should respond as if
the user had clicked the default button.

• Key-down events for the Esc and Command-period keystrokes, to which your application
should respond as if the user clicked the Cancel button.

• Key-down and auto-key events in editable text items, in response to which your application
should call DialogSelect (which will call TextEdit to automatically handle the keystrokes).

Activate and Update Events in Movable Modal and Modeless Dialog Boxes

Your application should be prepared to handle activate and update events for both modeless and
movable modal dialog boxes.

You can use DialogSelect to assist you in handling update and activate events.  For faster
performance, you may want to use the UpdateDialog function when handling update events.  Both
DialogSelect and UpdateDialog use SetPort to make the dialog box the current graphics port before
redrawing or updating it.

You should use HiliteControl to make the buttons and other controls inactive in a movable modal or
modeless dialog box when you deactivate it.  When you activate a movable modal or modeless dialog
box again, you should use HiliteControl to make the controls active.
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Because users can switch out your application when you display a movable modal dialog box, your
application must handle activate events for it too.

In response to an update event, DialogSelect calls BeginUpdate, DrawDialog (to redraw the entire
dialog box), and then EndUpdate.  The faster alternative (UpdateDialog) redraws only the update region.
It must be preceded by a BeginUpdate call and followed by an EndUpdate call.

Closing Dialog Boxes

Use CloseDialog to dispose of a dialog box if you allocated the memory for the dialog record yourself,
otherwise use DisposeDialog.

CloseDialog removes a dialog from the screen and deletes it from the window list.  It also releases
memory occupied by the data structures associated with the dialog box, and all the items in the dialog
box (except for pictures and icons, which might be shared by other resources) and any data structures
associated with them — for example, the region occupied by the scroll box of a scroll bar.  CloseDialog
does not dispose of the dialog record or the 'DITL' resource.

DisposeDialog, on the other hand, calls CloseDialog  and, in addition, releases the memory occupied
by the dialog record and item list resource.

For modeless and movable modal dialog boxes, you might find it more efficient to hide the dialog box
with HideWindow rather than remove its structures.  In that way, the dialog will remain available, and in
the same location and with the same settings as when it was last used.

If you adjust the menus when you display a dialog box, be sure to return them to an appropriate state
when you close the dialog box.

Main Dialog Manager Constants, Data Types and Routines

Constants

Item Types for GetDialogItem  and SetDialogItem

ctrlItem = 4 Add this constant to the next four constants.
btnCtrl = 0
chkCtrl = 1
radCtrl = 2
resCtrl = 3
statText = 8
editText = 16
iconItem = 32
picItem = 64
userItem = 0
helpItem = 1
itemDisable = 28 Add to any of the above to disable it.

Item Numbers for OK and Cancel Buttons in Alert Boxes

ok = 1
cancel = 2

New, More Standard Names For Dialog Item Constants

kControlDialogItem = ctrlItem
kButtonDialogItem = ctrlItem + btnCtrl
kCheckBoxDialogItem = ctrlItem + chkCtrl
kRadioButtonDialogItem = ctrlItem + radCtrl
kResourceControlDialogItem = ctrlItem + resCtrl
kStaticTextDialogItem = statText
kEditTextDialogItem = editText
kIconDialogItem = iconItem
kPictureDialogItem = picItem
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kUserDialogItem = userItem
kItemDisableBit = itemDisable
kStdOkItemIndex = ok
kStdCancelItemIndex = cancel

Resource IDs of Alert Box Icons

stopIcon = 0
noteIcon = 1
cautionIcon = 2

Constants Use for theMethod  Parameter in AppendDITL

overlayDITL = 0
appendDITLRight = 1
appendDITLBottom = 2

Constants Use for procID  Parameter in NewDialog  and NewColorDialog

dBoxProc = 1 Modal dialog box.
noGrowDocProc = 4 Modeless dialog box.
movableDBoxProc = 5 Movable modal dialog box.

Data Types

DialogPtr = WindowPtr;
DialogRef = DialogPtr;

Dialog Record

type
DialogRecord = record

window: WindowRecord;
items: Handle;
textH: TEHandle;
editField: integer;
editOpen: integer;
aDefItem: integer;

end;

DialogPeek = ^DialogRecord;

Routines

Note:  Some Dialog Manager routines can be accessed using more than one spelling of the routine's name,
depending on the interface files supported by your development environment.  The following reflects the newest
spellings, as specified in version 2.1 of the Universal Interfaces.

Initialising the Dialog Manager

procedure InitDialogs(ignored: UNIV Ptr);
procedure ErrorSound(soundProc: SoundUPP);
procedure SetDialogFont( value: integer );

Creating Alerts

function Alert(alertID: integer; modalFilter: ModalFilterUPP): integer;
function StopAlert(alertID: integer; modalFilter: ModalFilterUPP): integer;
function NoteAlert(alertID: integer; modalFilter: ModalFilterUPP): integer;
function CautionAlert(alertID: integer; modalFilter: ModalFilterUPP): integer;
function GetAlertStage : integer;
procedure ResetAlertStage;

Creating and Disposing of Dialog Boxes

function GetNewDialog(dialogID: integer; dStorage: UNIV Ptr; behind: WindowRef): DialogRef;
function NewDialog(wStorage: UNIV Ptr; var boundsRect: Rect; title: ConstStr255Param;

visible: boolean; procID: integer; behind: WindowRef; goAwayFlag: boolean;
refCon: longint; itmLstHndl: Handle): DialogRef;

function NewColorDialog(dStorage: UNIV Ptr; var boundsRect: Rect; title: ConstStr255Param;
visible: boolean; procID: integer; behind: WindowRef; goAwayFlag: boolean;
refCon: longint; items: Handle): DialogRef;
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procedure CloseDialog(theDialog: DialogRef);
procedure DisposeDialog(theDialog: DialogRef);

Manipulating Items in Alert and Dialog Boxes

procedure GetDialogItem(theDialog: DialogRef; itemNo: integer; var itemType: integer;
var item: Handle; var box: Rect);

procedure SetDialogItem(theDialog: DialogRef; itemNo: integer; itemType: integer;
item: Handle; var box: Rect);

procedure HideDialogItem(theDialog: DialogRef; itemNo: integer);
procedure ShowDialogItem(theDialog: DialogRef; itemNo: integer);
function FindDialogItem(theDialog: DialogRef; thePt: Point): integer;
procedure AppendDITL(theDialog: DialogRef; theHandle: Handle; method: DITLMethod);
procedure ShortenDITL(theDialog: DialogRef; numberItems: integer);
function CountDITL(theDialog: DialogRef): integer;

Handling Text in Alert and Dialog Boxes

procedure ParamText(param0: ConstStr255Param; param1: ConstStr255Param;
param2: ConstStr255Param; param3: ConstStr255Param);

procedure GetDialogItemText(item: Handle; var text: Str255);
procedure SetDialogItemText(item: Handle; text: ConstStr255Param);
procedure SelectDialogItemText(theDialog: DialogRef; itemNo: integer; strtSel: integer;

endSel: integer);
procedure DialogCut(theDialog: DialogRef);
procedure DialogPaste(theDialog: DialogRef);
procedure DialogCopy(theDialog: DialogRef);
procedure DialogDelete(theDialog: DialogRef);

Handling Events in Dialog Boxes

procedure ModalDialog(modalFilter: ModalFilterUPP; var itemHit: integer);
function IsDialogEvent(var theEvent: EventRecord): boolean;
function DialogSelect(var theEvent: EventRecord; var theDialog: DialogRef;

var itemHit: integer): boolean;
procedure DrawDialog(theDialog: DialogRef);
procedure UpdateDialog(theDialog: DialogRef; updateRgn: RgnHandle);

Demonstration Program
{ ######################################################################################1

// DialogsAndAlertsPascal.p2

// #####################################################################################3

//4

// This program:5

//6

// • Opens a window for the purposes of displaying text and for proving correct window7

// updating and activation/deactivation in the presence of alert and dialog boxes.8

//9

// • Allows the user to invoke a demonstration alert, a modal dialog box, a movable10

// modal dialog box and a modeless dialog box via the Demonstration menu.11

//12

// The modal dialog box contains three checkboxes.13

//14

// The movable modal dialog box contains three radio buttons.15

//16

// The modeless dialog box contains an icon and an editable text item.  The editable text17

// item is supported by the Edit menu Cut, Copy, Paste and Clear commands.18

//19

// An application-defined event filter function is used for the alert box and modal20

// dialog box.21

//22

// An application-defined function is used to draw the bold outline around the default23

// button in the modal, movable modal and modeless dialog boxes.24

//25

// The program utilises the following resources:26

//27

// • An 'MBAR' resource, and 'MENU' resources for Apple, File, Demonstration and Help28

// menus (preload, non-purgeable).29

//30

// • A 'WIND' resource (purgeable) (initially visible).31

//32

// • An 'ALRT' resource (purgeable).33
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//34

// • 'DLOG' resources (purgeable) (initially not visible) and associated 'DITL'35

// resources (purgeable).36

//37

// • 'dctb' resources (purgeable) to force the Dialog Manager to create colour graphics38

// ports for the movable modal and modeless dialog boxes.39

//40

// • A 'cicn' resource (purgeable).41

//42

// • A 'SIZE' resource with the acceptSuspendResumeEvents and doesActivateOnFGSwitch,43

// and is32BitCompatible flags set.44

//45

// ##################################################################################### }46

47

program DialogsAndAlertsPascal(input, output);48

49

{ ………………………………………………………………………………………………………………… include the following Universal Interfaces }50

51

uses52

53

Controls, Windows, Menus, Quickdraw, Fonts, Events, OSUtils, Processes, TextUtils, Dialogs,54

TextEdit, QuickdrawText, Types, Memory, Palettes, ToolUtils, Devices, SegLoad,55

  Sound, OSUtils;56

57

{ ………………………………………………………………………………………………………………………………………………… define the following constants }58

59

const60

61

mApple = 128;62

iAbout = 1;63

mFile = 129;64

iClose = 4;65

iQuit = 11;66

mEdit = 130;67

 iCut = 3;68

 iCopy = 4;69

 iPaste = 5;70

 iClear = 6;71

mDemonstration = 131;72

 iAlert = 1;73

 iModal = 2;74

 iMovable = 3;75

 iModeless = 4;76

rMenubar = 128;77

rNewWindow = 128;78

rAlert = 128;79

 iOK = 1;80

 iCancel = 2;81

 iUserItem = 3;82

rModal = 129;83

iGridSnap = 4;84

 iShowGrid = 5;85

 iShowRulers = 6;86

rMovable = 130;87

 iCharcoal = 4;88

 iOilPaint = 5;89

 iWaterColour = 6;90

rModeless = 131;91

 iSearch = 1;92

 iEditText = 4;93

94

kMovableModal = 1;95

kModeless = 2;96

97

kReturn = $0D;98

kEnter = $03;99

kEscape  = $1B;100

kPeriod = $2E;101

102

kMaxLong = $7FFFFFFF;103

104

{ ………………………………………………………………………………………………………………………………………………………………………………… user-defined types }105

106

type107

108

DocRec = record109
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vScrollbarHdl, hScrollbarHdl : ControlHandle;110

end;111

112

DocRecPointer = ^DocRec;113

DocRecHandle = ^DocRecPointer;114

115

{ ……………………………………………………………………………………………………………………………………………………………………………………… global variables }116

117

var118

119

gWindowPtr : WindowPtr;120

gSleepTime : longint;121

gDone : boolean;122

gInBackground : boolean;123

gGridSnap : integer;124

gShowGrid : integer;125

gShowRule : integer;126

gBrushType : integer;127

gOldBrushType : integer;128

gModelessDlgPtr : DialogRef;129

130

menubarHdl : Handle;131

menuHdl : MenuHandle;132

docRecHdl : DocRecHandle;133

134

{ ####################################################################### DoInitManagers }135

136

procedure DoInitManagers;137

138

begin139

MaxApplZone;140

MoreMasters;141

142

InitGraf(@qd.thePort);143

InitFonts;144

InitWindows;145

InitMenus;146

TEInit;147

InitDialogs(nil);148

149

InitCursor;150

FlushEvents(everyEvent, 0);151

end;152

{of procedure DoInitManagers}153

154

{ ############################################################################### DoIdle }155

156

procedure DoIdle(var eventRec : EventRecord);157

158

var159

myWindowPtr : WindowPtr;160

dialogType : integer;161

itemHit : integer;162

ignored : boolean;163

164

begin165

myWindowPtr := FrontWindow;166

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then167

begin168

dialogType := WindowPeek(myWindowPtr)^.refCon;169

170

if (dialogType = kModeless) then171

ignored := DialogSelect(eventRec, DialogPtr(myWindowPtr), itemHit);172

end;173

end;174

{of procedure DoIdle}175

176

{ ######################################################################## DoAdjustMenus }177

178

procedure DoAdjustMenus;179

180

var181

myWindowPtr : WindowPtr;182

dialogType : integer;183

menuHdl : MenuHandle;184

185
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begin186

myWindowPtr := FrontWindow;187

188

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then189

begin190

dialogType := WindowPeek(myWindowPtr)^.refCon;191

192

case (dialogType) of193

194

kMovableModal:195

begin196

menuHdl := GetMenuHandle(mFile);197

DisableItem(menuHdl, 0);198

menuHdl := GetMenuHandle(mEdit);199

DisableItem(menuHdl, 0);200

menuHdl := GetMenuHandle(mDemonstration);201

DisableItem(menuHdl, 0);202

EnableItem(menuHdl, 4);203

end;204

205

kModeless:206

begin207

menuHdl := GetMenuHandle(mFile);208

EnableItem(menuHdl, 0);209

EnableItem(menuHdl, 4);210

menuHdl := GetMenuHandle(mEdit);211

EnableItem(menuHdl, 0);212

menuHdl := GetMenuHandle(mDemonstration);213

EnableItem(menuHdl, 0);214

DisableItem(menuHdl, 4);215

end;216

end;217

{of case statement}218

end219

220

else if (WindowPeek(myWindowPtr)^.windowKind = userKind) then221

begin222

menuHdl := GetMenuHandle(mFile);223

EnableItem(menuHdl, 0);224

DisableItem(menuHdl, 4);225

menuHdl := GetMenuHandle(mEdit);226

DisableItem(menuHdl, 0);227

menuHdl := GetMenuHandle(mDemonstration);228

EnableItem(menuHdl, 0);229

EnableItem(menuHdl, 4);230

end;231

232

DrawMenuBar;233

end;234

{of procedure DoAdjustMenus}235

236

{ ################################################################ DoKeyDownMovableModal }237

238

procedure DoKeyDownMovableModal(var eventRec : EventRecord);239

240

var241

myWindowPtr : WindowPtr;242

charCode : char;243

itemType : integer;244

itemHandle : Handle;245

itemRect : Rect;246

finalTicks : UInt32;247

248

begin249

myWindowPtr := FrontWindow;250

charCode := chr(BAnd(eventRec.message, charCodeMask));251

252

if ((charCode = char(kReturn)) or (charCode = char(kEnter))) then253

begin254

GetDialogItem(DialogRef(myWindowPtr), iOK, itemType, itemHandle, itemRect);255

HiliteControl(ControlHandle(itemHandle), kControlButtonPart);256

Delay(8, finalTicks);257

HiliteControl(ControlHandle(itemHandle), 0);258

DisposeDialog(DialogRef(myWindowPtr));259

end260

261
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else if ((charCode = char(kEscape)) or ((BAnd(eventRec.modifiers, cmdKey) <> 0)262

 and (charCode = char(kPeriod)))) then263

begin264

GetDialogItem(DialogRef(myWindowPtr), iCancel, itemType, itemHandle, itemRect);265

HiliteControl(ControlHandle(itemHandle), kControlButtonPart);266

Delay(8, finalTicks);267

HiliteControl(ControlHandle(itemHandle), 0);268

gBrushType := gOldBrushType;269

DisposeDialog(DialogRef(myWindowPtr));270

end;271

272

end;273

{of procedure DoKeyDownDocument}274

275

{ #################################################################### DoItemHitModeless }276

277

procedure DoItemHitModeless(myDialogRef : DialogRef);278

279

var280

oldPort : WindowPtr;281

printRect, itemRect : Rect;282

itemType : integer;283

itemHdl : Handle;284

itemString : string;285

286

begin287

GetPort(oldPort);288

SetPort(gWindowPtr);289

290

SetRect(printRect, 15, 13, 369, 36);291

292

PenMode(patBic);293

PaintRect(printRect);294

295

GetDialogItem(myDialogRef, iEditText, itemType, itemHdl, itemRect);296

GetDialogItemText(itemHdl, itemString);297

MoveTo(20, 29);298

DrawString('Search string:  ');299

DrawString(itemString);300

301

PenNormal;302

SetPort(oldPort);303

end;304

{of procedure DoItemHitModeless}305

306

{ #################################################################### DoKeyDownModeless }307

308

procedure DoKeyDownModeless(var eventRec : EventRecord);309

310

var311

myWindowPtr : WindowPtr;312

charCode : char;313

itemType : integer;314

itemHandle : Handle;315

itemRect : Rect;316

finalTicks : UInt32;317

theDialogRef : DialogRef;318

itemHit : integer;319

ignored : boolean;320

321

begin322

myWindowPtr := FrontWindow;323

charCode := chr(BAnd(eventRec.message, charCodeMask));324

325

if ((charCode = char(kReturn)) or (charCode = char(kEnter)))then326

begin327

GetDialogItem(DialogRef(myWindowPtr), iSearch, itemType, itemHandle, itemRect);328

HiliteControl(ControlHandle(itemHandle), kControlButtonPart);329

Delay(8, finalTicks);330

HiliteControl(ControlHandle(itemHandle), 0);331

DoItemHitModeless(DialogRef(myWindowPtr));332

end333

334

else begin335

theDialogRef := DialogRef(myWindowPtr);336

ignored := DialogSelect(eventRec, theDialogRef, itemHit);337
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end;338

339

end;340

{of procedure DoKeyDownModeless}341

342

{ ##################################################################### DoUpdateDocument }343

344

procedure DoUpdateDocument(var eventRec : EventRecord);345

346

var347

myWindowPtr : WindowPtr;348

paintRect : Rect;349

fillPattern : Pattern;350

351

begin352

myWindowPtr := WindowPtr(eventRec.message);353

354

BeginUpdate(myWindowPtr);355

356

if not (EmptyRgn(myWindowPtr^.visRgn)) then357

begin358

SetPort(myWindowPtr);359

360

EraseRgn(myWindowPtr^.visRgn);361

362

paintRect := myWindowPtr^.portRect;363

paintRect.right := paintRect.right - 15;364

paintRect.bottom := paintRect.bottom - 15;365

GetIndPattern(fillPattern, 0, 16);366

FillRect(paintRect, fillPattern);367

368

DrawGrowIcon(myWindowPtr);369

end;370

371

EndUpdate(myWindowPtr);372

end;373

{of procedure DoUpdateDocument}374

375

{ ############################################################ DoUpdateMovableOrModeless }376

377

procedure DoUpdateMovableOrModeless(var eventRec : EventRecord);378

379

var380

myWindowPtr : WindowPtr;381

382

begin383

myWindowPtr := WindowPtr(eventRec.message);384

385

BeginUpdate(myWindowPtr);386

UpdateDialog(myWindowPtr, myWindowPtr^.visRgn);387

EndUpdate(myWindowPtr);388

end;389

{of procedure DoUpdateMovableOrModeless}390

391

{ ################################################################### DoActivateDocument }392

393

procedure DoActivateDocument(myWindowPtr : WindowPtr; becomingActive : boolean);394

395

begin396

if (becomingActive) then397

DoAdjustMenus;398

399

DrawGrowIcon(myWindowPtr);400

end;401

{of procedure DoActivateDocument}402

403

{ ############################################################# DrawDefaultButtonOutline }404

405

procedure DrawDefaultButtonOutline(myDialogRef : DialogRef; theItem : integer);406

407

var408

oldPort : WindowPtr;409

oldPenState : PenState;410

itemType : integer;411

itemHandle : Handle;412

itemRect : Rect;413
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colGrafPtr : CGrafPtr;414

isColour : boolean;415

buttonOval : SInt8;416

backColour : RGBColor;417

foreSaveColour : RGBColor;418

newForeColour : RGBColor;419

newGray : boolean;420

targetDevice : GDHandle;421

422

begin423

GetPort(oldPort);424

GetPenState(oldPenState);425

426

GetDialogItem(myDialogRef, iOK, itemType, itemHandle, itemRect);427

SetPort(ControlHandle(itemHandle)^^.contrlOwner);428

InsetRect(itemRect, -4, -4);429

430

colGrafPtr := CGrafPtr(ControlHandle(itemHandle)^^.contrlOwner);431

432

if (BAnd(BSR(colGrafPtr ^.portVersion, 14), $00000003) <> 0)433

then isColour := true434

else isColour := false;435

436

buttonOval := trunc((itemRect.bottom - itemRect.top) / 2) + 2;437

438

if (ControlHandle(itemHandle)^^.contrlHilite = 255)439

then begin440

newGray := false;441

442

if (isColour) then443

begin444

GetBackColor(backColour);445

GetForeColor(foreSaveColour);446

newForeColour := foreSaveColour;447

targetDevice := GetMainDevice;448

newGray := GetGray(targetDevice, backColour, newForeColour);449

end;450

451

if (newGray)452

then RGBForeColor(newForeColour)453

else PenPat(qd.gray);454

455

PenSize(3, 3);456

FrameRoundRect(itemRect, buttonOval, buttonOval);457

458

if (isColour) then459

RGBForeColor(foreSaveColour);460

end461

462

else begin463

PenPat(qd.black);464

PenSize(3, 3);465

FrameRoundRect(itemRect, buttonOval, buttonOval);466

end;467

468

SetPenState(oldPenState);469

SetPort(oldPort);470

end;471

{of procedure DrawDefaultButtonOutline}472

473

{ ############################################################### DoActivateMovableModal }474

475

procedure DoActivateMovableModal(myWindowPtr : WindowPtr; becomingActive : boolean);476

477

var478

a, itemType : integer;479

itemHdl : Handle;480

itemRect : Rect;481

482

begin483

if (becomingActive)484

then begin485

for a := iOK to iWaterColour do486

begin487

if (a <> iUserItem) then488

begin489
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GetDialogItem(DialogRef(myWindowPtr), a, itemType, itemHdl, itemRect);490

HiliteControl(ControlHandle(itemHdl), 0);491

end;492

end;493

DrawDefaultButtonOutline(DialogRef(myWindowPtr), iOK);494

DoAdjustMenus;495

end496

497

else begin498

for a := iOK to iWaterColour do499

begin500

if (a <> iUserItem) then501

begin502

GetDialogItem(DialogRef(myWindowPtr), a, itemType, itemHdl, itemRect);503

HiliteControl(ControlHandle(itemHdl), 255);504

end;505

end;506

DrawDefaultButtonOutline(DialogRef(myWindowPtr), iOK);507

end;508

end;509

{of procedure DoActivateMovableModal}510

511

{ ################################################################### DoActivateModeless }512

513

procedure DoActivateModeless(myWindowPtr : WindowPtr; becomingActive : boolean);514

515

var516

itemType : integer;517

itemHdl : Handle;518

itemRect : Rect;519

520

begin521

if (becomingActive)522

then begin523

GetDialogItem(DialogRef(myWindowPtr), iSearch, itemType, itemHdl, itemRect);524

HiliteControl(ControlHandle(itemHdl), 0);525

526

DrawDefaultButtonOutline(DialogRef(myWindowPtr), iSearch);527

SelectDialogItemText(DialogRef(myWindowPtr), iEditText, 0, 32767);528

gSleepTime := LMGetCaretTime;529

DoAdjustMenus;530

end531

532

else begin533

GetDialogItem(DialogRef(myWindowPtr), iSearch, itemType, itemHdl, itemRect);534

HiliteControl(ControlHandle(itemHdl), 255);535

536

DrawDefaultButtonOutline(DialogRef(myWindowPtr), iSearch);537

SelectDialogItemText(DialogRef(myWindowPtr), iEditText, 0, 0);538

gSleepTime := kMaxLong;539

end;540

end;541

{of procedure DoActivateModeless}542

543

{ ########################################################################### DoActivate }544

545

procedure DoActivate(var eventRec : EventRecord);546

547

var548

myWindowPtr : WindowPtr;549

dialogType : integer;550

becomingActive : boolean;551

552

begin553

myWindowPtr := WindowPtr(eventRec.message);554

becomingActive := BAnd(eventRec.modifiers, activeFlag) = activeFlag;555

556

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then557

begin558

dialogType := WindowPeek(myWindowPtr)^.refCon;559

560

if (dialogType = kMovableModal) then561

DoActivateMovableModal(myWindowPtr, becomingActive)562

else if (dialogType = kModeless) then563

DoActivateModeless(myWindowPtr, becomingActive);564

end565
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566

else if (WindowPeek(myWindowPtr)^.windowKind = userKind) then567

DoActivateDocument(myWindowPtr, becomingActive);568

569

end;570

{of procedure DoActivate}571

572

{ ############################################################################ DoOSEvent }573

574

procedure DoOSEvent(var eventRec : EventRecord);575

576

var577

dialogType : integer;578

myWindowPtr : WindowPtr;579

580

begin581

myWindowPtr := FrontWindow;582

583

case BAnd(BSR(eventRec.message, 24), $000000FF) of584

585

suspendResumeMessage:586

begin587

gInBackground := BAnd(eventRec.message, resumeFlag) = 0;588

589

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then590

begin591

dialogType := WindowPeek(myWindowPtr)^.refCon;592

593

if (dialogType = kMovableModal) then594

DoActivateMovableModal(myWindowPtr, not(gInBackground))595

else if (dialogType = kModeless) then596

DoActivateModeless(myWindowPtr, not(gInBackground));597

end598

599

else if (WindowPeek(myWindowPtr)^.windowKind = userKind) then600

DoActivateDocument(myWindowPtr, not(gInBackground));601

end;602

603

mouseMovedMessage:604

begin605

end;606

607

end;608

{of outer case statement}609

end;610

{of procedure DoOSEvent}611

612

{ ############################################################################# DoUpdate }613

614

procedure DoUpdate(var eventRec : EventRecord);615

616

var617

myWindowPtr : WindowPtr;618

dialogType : integer;619

620

begin621

myWindowPtr := WindowPtr(eventRec.message);622

623

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then624

begin625

dialogType := WindowPeek(myWindowPtr)^.refCon;626

627

if ((dialogType = kMovableModal) or (dialogType = kModeless)) then628

DoUpdateMovableOrModeless(eventRec);629

end630

631

else if (WindowPeek(myWindowPtr)^.windowKind = userKind) then632

DoUpdateDocument(eventRec);633

634

end;635

{of procedure DoUpdate}636

637

{ ####################################################################### DoHideModeless }638

639

procedure DoHideModeless;640

641
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var642

myWindowPtr : WindowPtr;643

dialogType : integer;644

645

begin646

myWindowPtr := FrontWindow;647

648

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then649

begin650

dialogType := WindowPeek(myWindowPtr)^.refCon;651

652

if (dialogType = kModeless) then653

begin654

HideWindow(myWindowPtr);655

InvalRgn(gWindowPtr^.visRgn);656

gSleepTime := kMaxLong;657

end;658

end;659

end;660

{of procedure DoHideModeless}661

662

{ ########################################################################### DoEditMenu }663

664

procedure DoEditMenu(menuItem : integer);665

666

var667

myWindowPtr : WindowPtr;668

dialogType : integer;669

670

begin671

myWindowPtr := FrontWindow;672

673

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then674

begin675

dialogType := WindowPeek(myWindowPtr)^.refCon;676

677

if (dialogType = kModeless) then678

case (menuItem) of679

680

iCut:681

begin682

DialogCut(DialogRef(myWindowPtr));683

end;684

685

iCopy:686

begin687

DialogCopy(DialogRef(myWindowPtr));688

end;689

690

iPaste:691

begin692

DialogPaste(DialogRef(myWindowPtr));693

end;694

695

iClear:696

begin697

DialogDelete(DialogRef(myWindowPtr));698

end;699

end;700

{of case statement}701

end;702

end;703

{of procedure DoEditMenu}704

705

{ ########################################################################## EventFilter }706

707

function EventFilter(myDialogRef : DialogRef; eventRec : EventRecord;708

  var itemHit : integer) : boolean;709

710

var711

charCode : char;712

itemType : integer;713

itemHandle : Handle;714

itemRect : Rect;715

finalTicks : UInt32;716

handledEvent : boolean;717
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718

begin719

handledEvent := false;720

721

if ((eventRec.what = updateEvt) and (WindowPtr(eventRec.message) <> myDialogRef))722

then DoUpdate(eventRec)723

else begin724

case (eventRec.what) of725

726

keyDown, autoKey:727

begin728

charCode := chr(BAnd(eventRec.message, charCodeMask));729

if ((charCode = char(kReturn)) or (charCode = char(kEnter))) then730

begin731

GetDialogItem(myDialogRef, iOK, itemType, itemHandle, itemRect);732

HiliteControl(ControlHandle(itemHandle), kControlButtonPart);733

Delay(8, finalTicks);734

HiliteControl(ControlHandle(itemHandle), 0);735

handledEvent := true;736

itemHit := iOK;737

end;738

if ((charCode = char(kEscape)) or ((BAnd(eventRec.modifiers, cmdKey) <> 0)739

and (charCode = char(kPeriod)))) then740

begin741

GetDialogItem(myDialogRef, iCancel, itemType, itemHandle, itemRect);742

HiliteControl(ControlHandle(itemHandle), kControlButtonPart);743

Delay(8, finalTicks);744

HiliteControl(ControlHandle(itemHandle),0);745

handledEvent := true;746

itemHit := iCancel;747

end;748

749

{Other keyboard equivalents handled here.}750

end;751

752

{Disk-inserted and other events handled here.}753

end;754

{of case statement}755

end;756

757

EventFilter := handledEvent;758

end;759

{of procedure EventFilter}760

761

{ ######################################################################## DoModalDialog }762

763

function DoModalDialog : boolean;764

765

var766

modalDlgPtr : DialogRef;767

itemType, itemHit : integer;768

itemHdl : Handle;769

itemRect : Rect;770

771

begin772

773

modalDlgPtr := GetNewDialog(rModal, nil, WindowPtr(-1));774

if (modalDlgPtr = nil) then775

begin776

DoModalDialog := false;777

Exit(DoModalDialog);778

end;779

780

GetDialogItem(modalDlgPtr, iUserItem, itemType, itemHdl, itemRect);781

SetDialogItem(modalDlgPtr, iUserItem, itemType, Handle(@DrawDefaultButtonOutline),itemRect);782

783

GetDialogItem(modalDlgPtr, iGridSnap, itemType, itemHdl, itemRect);784

SetControlValue(ControlHandle(itemHdl), gGridSnap);785

786

GetDialogItem(modalDlgPtr, iShowGrid, itemType, itemHdl, itemRect);787

SetControlValue(ControlHandle(itemHdl), gShowGrid);788

789

GetDialogItem(modalDlgPtr, iShowRulers, itemType, itemHdl, itemRect);790

SetControlValue(ControlHandle(itemHdl), gShowRule);791

792

ShowWindow(modalDlgPtr);793
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794

repeat795

ModalDialog(NewModalFilterProc(ModalFilterProcPtr(@EventFilter)), itemHit);796

GetDialogItem(modalDlgPtr, itemHit, itemType, itemHdl, itemRect);797

if (GetControlValue(ControlHandle(itemHdl)) = 1)798

then SetControlValue(ControlHandle(itemHdl), 0)799

else if (GetControlValue(ControlHandle(itemHdl)) = 0) then800

SetControlValue(ControlHandle(itemHdl), 1);801

802

until ((itemHit = iOK) or (itemHit = iCancel));803

804

if (itemHit = iOK) then805

begin806

GetDialogItem(modalDlgPtr, iGridSnap, itemType, itemHdl, itemRect);807

gGridSnap := GetControlValue(ControlHandle(itemHdl));808

809

GetDialogItem(modalDlgPtr, iShowGrid, itemType, itemHdl, itemRect);810

gShowGrid := GetControlValue(ControlHandle(itemHdl));811

812

GetDialogItem(modalDlgPtr, iShowRulers, itemType, itemHdl, itemRect);813

gShowRule := GetControlValue(ControlHandle(itemHdl));814

end;815

816

DisposeDialog(modalDlgPtr);817

818

DoModalDialog := true;819

end;820

{of function DoModalDialog}821

822

{ ################################################################# DoMovableModalDialog }823

824

function DoMovableModalDialog : boolean;825

826

var827

modalDlgPtr : DialogRef;828

itemType : integer;829

itemHdl : Handle;830

itemRect : Rect;831

832

begin833

modalDlgPtr := GetNewDialog(rMovable, nil, WindowPtr(-1));834

835

if (modalDlgPtr = nil) then836

begin837

DoMovableModalDialog := false;838

Exit(DoMovableModalDialog);839

end;840

841

SetWRefCon(modalDlgPtr, longint(kMovableModal));842

843

GetDialogItem(modalDlgPtr, iUserItem, itemType, itemHdl, itemRect);844

845

SetDialogItem(modalDlgPtr, iUserItem, itemType, Handle(@DrawDefaultButtonOutline),itemRect);846

847

GetDialogItem(modalDlgPtr, gBrushType, itemType, itemHdl, itemRect);848

SetControlValue(ControlHandle(itemHdl),1);849

850

ShowWindow(modalDlgPtr);851

852

gOldBrushType := gBrushType;853

854

DoMovableModalDialog := true;855

end;856

{of function DoMovableModalDialog}857

858

{ ##################################################################### DoModelessDialog }859

860

function DoModelessDialog : boolean;861

862

var863

itemType : integer;864

itemHdl : Handle;865

itemRect : Rect;866

867

begin868

if (gModelessDlgPtr = nil)869



6-34 Dialogs and Alerts

then begin870

gModelessDlgPtr := GetNewDialog(rModeless, nil, WindowPtr(-1));871

if (gModelessDlgPtr = nil) then872

begin873

DoModelessDialog := false;874

Exit(DoModelessDialog);875

end;876

877

SetWRefCon(gModelessDlgPtr, longint(kModeless));878

879

GetDialogItem(gModelessDlgPtr, iUserItem, itemType, itemHdl, itemRect);880

SetDialogItem(gModelessDlgPtr, iUserItem, itemType, Handle(@DrawDefaultButtonOutline),881

itemRect);882

883

ShowWindow(gModelessDlgPtr);884

SelectDialogItemText(gModelessDlgPtr, iEditText, 0, 32767);885

end886

887

else begin888

ShowWindow(gModelessDlgPtr);889

SelectWindow(gModelessDlgPtr);890

end;891

892

DoModelessDialog := true;893

end;894

{of function DoModelessDialog}895

896

{ ################################################################## DoDemonstrationMenu }897

898

procedure DoDemonstrationMenu(menuItem : integer);899

900

var901

myWindowPtr : WindowPtr;902

theRect : Rect;903

ignored : integer;904

905

begin906

case (menuItem) of907

908

iAlert: begin909

myWindowPtr := FrontWindow;910

if (GetAlertStage > 0) then911

begin912

if (myWindowPtr <> nil) then913

begin914

if (WindowPeek(myWindowPtr)^.windowKind <> dialogKind) then915

begin916

SetRect(theRect, myWindowPtr^.portRect.right - 15,917

myWindowPtr^.portRect.bottom - 15, myWindowPtr^.portRect.right,918

myWindowPtr^.portRect.bottom);919

InvalRect(theRect);920

DoActivateDocument(myWindowPtr, false);921

end922

else if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then923

begin924

DoActivateModeless(myWindowPtr, false);925

end;926

end;927

end;928

ignored := NoteAlert(rAlert, ModalFilterUPP(@EventFilter));929

end;930

931

iModal: begin932

myWindowPtr := FrontWindow;933

if (myWindowPtr <> nil) then934

begin935

if (WindowPeek(myWindowPtr)^.windowKind <> dialogKind) then936

begin937

SetRect(theRect, myWindowPtr^.portRect.right - 15,938

myWindowPtr^.portRect.bottom - 15, myWindowPtr^.portRect.right,939

myWindowPtr^.portRect.bottom);940

InvalRect(theRect);941

DoActivateDocument(myWindowPtr, false);942

end943

else if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then944

begin945
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DoActivateModeless(myWindowPtr, false);946

end;947

end;948

949

if not (DoModalDialog) then950

begin951

SysBeep(10);952

ExitToShell;953

end;954

end;955

956

iMovable: begin957

if not (DoMovableModalDialog) then958

begin959

SysBeep(10);960

ExitToShell;961

end;962

end;963

964

iModeless: begin965

if not (DoModelessDialog) then966

begin967

SysBeep(10);968

ExitToShell;969

end;970

end;971

end;972

{of case statement}973

974

end;975

{of procedure DoDemonstrationMenu}976

977

{ ######################################################################### DoMenuChoice }978

979

procedure DoMenuChoice(menuChoice : longint);980

981

var982

menuID, menuItem : integer;983

itemName : string;984

daDriverRefNum : integer;985

986

begin987

menuID := HiWord(menuChoice);988

menuItem := LoWord(menuChoice);989

990

if (menuID = 0) then991

Exit(DoMenuChoice);992

993

case (menuID) of994

995

mApple:996

begin997

if (menuItem = iAbout)998

then SysBeep(10)999

else begin1000

GetMenuItemText(GetMenuHandle(mApple), menuItem, itemName);1001

daDriverRefNum := OpenDeskAcc(itemName);1002

end;1003

end;1004

1005

mFile:1006

begin1007

if (menuItem = iQuit)1008

then gDone := true1009

else if (menuItem = iClose) then1010

DoHideModeless;1011

end;1012

1013

mEdit:1014

begin1015

DoEditMenu(menuItem);1016

end;1017

1018

mDemonstration:1019

begin1020

DoDemonstrationMenu(menuItem);1021
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end;1022

end;1023

{of case statement}1024

1025

HiliteMenu(0);1026

end;1027

{of procedure DoMenuChoice}1028

1029

{ #################################################################### DoKeyDownDocument }1030

1031

procedure DoKeyDownDocument(var eventRec : EventRecord);1032

1033

var1034

charCode : char;1035

1036

begin1037

charCode := chr(BAnd(eventRec.message, charCodeMask));1038

1039

if (BAnd(eventRec.modifiers, cmdKey) <> 0) then1040

begin1041

DoAdjustMenus;1042

DoMenuChoice(MenuKey(charCode));1043

end;1044

end;1045

{of procedure DoKeyDownDocument}1046

1047

{ ############################################################################ DoKeyDown }1048

1049

procedure DoKeyDown(var eventRec : EventRecord);1050

1051

var1052

myWindowPtr : WindowPtr;1053

dialogType : integer;1054

1055

begin1056

myWindowPtr := FrontWindow;1057

1058

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then1059

begin1060

dialogType := WindowPeek(myWindowPtr)^.refCon;1061

1062

case (dialogType) of1063

1064

kMovableModal:1065

begin1066

DoKeyDownMovableModal(eventRec);1067

end;1068

1069

kModeless:1070

begin1071

DoKeyDownModeless(eventRec);1072

end;1073

end;1074

{of case statement}1075

end1076

1077

else if (WindowPeek(myWindowPtr)^.windowKind = userKind) then1078

DoKeyDownDocument(eventRec);1079

1080

end;1081

{of procedure DoKeyDown}1082

1083

{ ################################################################ DoItemHitMovableModal }1084

1085

procedure DoItemHitMovableModal(myDialogRef : DialogRef; itemHit : integer);1086

1087

var1088

a, itemType : integer;1089

itemHdl : Handle;1090

itemRect : Rect;1091

1092

begin1093

if ((itemHit = iCharcoal) or (itemHit = iOilPaint) or (itemHit = iWaterColour))1094

then begin1095

for a := iCharcoal to iWaterColour do1096

begin1097
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GetDialogItem(myDialogRef, a, itemType, itemHdl, itemRect);1098

SetControlValue(ControlHandle(itemHdl), 0);1099

end;1100

1101

GetDialogItem(myDialogRef, itemHit, itemType, itemHdl, itemRect);1102

SetControlValue(ControlHandle(itemHdl), 1);1103

gBrushType := itemHit;1104

end1105

1106

else begin1107

if ((itemHit = iOK) or (itemHit = iCancel)) then1108

begin1109

if (itemHit = iCancel) then1110

gBrushType := gOldBrushType;1111

DisposeDialog(myDialogRef);1112

end;1113

end;1114

end;1115

{of procedure DoItemHitMovableModal}1116

1117

{ ############################################################## InvalidateScrollBarArea }1118

1119

procedure InvalidateScrollBarArea(myWindowPtr : WindowPtr);1120

1121

var1122

tempRect : Rect;1123

1124

begin1125

SetPort(myWindowPtr);1126

1127

tempRect := myWindowPtr^.portRect;1128

tempRect.left := tempRect.right - 15;1129

InvalRect(tempRect);1130

1131

tempRect := myWindowPtr^.portRect;1132

tempRect.top := tempRect.bottom - 15;1133

InvalRect(tempRect);1134

end;1135

{of procedure InvalidateScrollBarArea}1136

1137

{ ########################################################################## DoInContent }1138

1139

procedure DoInContent(var eventRec : EventRecord);1140

1141

var1142

myWindowPtr : WindowPtr;1143

dialogType : integer;1144

myDialogRef : DialogRef;1145

itemHit : integer;1146

1147

begin1148

myWindowPtr := FrontWindow;1149

1150

if (WindowPeek(myWindowPtr)^.windowKind = dialogKind) then1151

begin1152

dialogType := WindowPeek(myWindowPtr)^.refCon;1153

1154

if (dialogType = kMovableModal) then1155

begin1156

if (DialogSelect(eventRec, myDialogRef, itemHit)) then1157

DoItemHitMovableModal(myDialogRef, itemHit);1158

end1159

1160

else if (dialogType = kModeless) then1161

begin1162

if (DialogSelect(eventRec, myDialogRef, itemHit)) then1163

DoItemHitModeless(myDialogRef);1164

end;1165

end1166

1167

else if (WindowPeek(myWindowPtr)^.windowKind = userKind) then1168

begin1169

{ Handle clicks in document content region here.}1170

end;1171

end;1172

{of procedure DoInContent}1173
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1174

{ ########################################################################## DoMouseDown }1175

1176

procedure DoMouseDown(eventRec : EventRecord);1177

1178

var1179

myWindowPtr : WindowPtr;1180

partCode : integer;1181

growRect : Rect;1182

newSize : longint;1183

1184

begin1185

partCode := FindWindow(eventRec.where, myWindowPtr);1186

1187

case (partCode) of1188

1189

inMenuBar:1190

begin1191

DoAdjustMenus;1192

DoMenuChoice(MenuSelect(eventRec.where));1193

end;1194

1195

inSysWindow:1196

begin1197

SystemClick(eventRec, myWindowPtr);1198

end;1199

1200

inContent:1201

begin1202

if (myWindowPtr <> FrontWindow)1203

then begin1204

if (WindowPeek(FrontWindow)^.refCon = kMovableModal)1205

then SysBeep(10)1206

else SelectWindow(myWindowPtr);1207

end1208

1209

else DoInContent(eventRec);1210

end;1211

1212

inDrag:1213

begin1214

if ((WindowPeek(FrontWindow)^.refCon = kMovableModal) and1215

 (WindowPeek(myWindowPtr)^.refCon <> kMovableModal)) then1216

begin1217

SysBeep(10);1218

Exit(DoMouseDown);1219

end;1220

DragWindow(myWindowPtr, eventRec.where, qd.screenBits.bounds);1221

end;1222

1223

inGoAway:1224

begin1225

if (TrackGoAway(myWindowPtr, eventRec.where)) then1226

DoHideModeless;1227

end;1228

1229

inGrow:1230

begin1231

growRect := qd.screenBits.bounds;1232

growRect.top := 80;1233

growRect.left := 160;1234

newSize := GrowWindow(myWindowPtr, eventRec.where, growRect);1235

if (newSize <> 0) then1236

begin1237

InvalidateScrollBarArea(myWindowPtr);1238

SizeWindow(myWindowPtr, LoWord(newSize), HiWord(newSize), true);1239

InvalidateScrollBarArea(myWindowPtr);1240

end;1241

end;1242

1243

end;1244

{of case statement}1245

end;1246

{of procedure DoMouseDown}1247

1248

{ ############################################################################# DoEvents }1249
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1250

procedure DoEvents(eventRec : EventRecord);1251

1252

begin1253

case (eventRec.what) of1254

1255

mouseDown:1256

begin1257

DoMouseDown(eventRec);1258

end;1259

1260

keyDown, autoKey:1261

begin1262

DoKeyDown(eventRec);1263

end;1264

1265

updateEvt:1266

begin1267

DoUpdate(eventRec);1268

end;1269

1270

activateEvt:1271

begin1272

DoActivate(eventRec);1273

end;1274

1275

osEvt:1276

begin1277

DoOSEvent(eventRec);1278

HiliteMenu(0);1279

end;1280

end;1281

{of case statement}1282

end;1283

{of procedure DoEvents}1284

1285

{ ############################################################################ EventLoop }1286

1287

procedure EventLoop;1288

1289

var1290

eventRec : EventRecord;1291

gotEvent : Boolean;1292

1293

begin1294

gSleepTime := kMaxLong;1295

1296

gDone := false;1297

1298

while not (gDone) do1299

begin1300

gotEvent := WaitNextEvent(everyEvent, eventRec, gSleepTime, nil);1301

1302

if (gotEvent)1303

then DoEvents(eventRec)1304

else DoIdle(eventRec);1305

end;1306

end;1307

{of procedure EventLoop}1308

1309

1310

{ ################################################################ start of main program }1311

1312

begin1313

1314

gGridSnap := 0;1315

gShowGrid := 0;1316

gShowRule := 0;1317

gBrushType := iCharcoal;1318

gOldBrushType := iCharcoal;1319

gModelessDlgPtr := nil;1320

1321

{ …………………………………………………………………………………………………………………………………………………………………… initialize managers }1322

1323

DoInitManagers;1324

1325
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{ …………………………………………………………………………………………………………………………………………………… set up menu bar and menus }1326

1327

menubarHdl := GetNewMBar(rMenubar);1328

if (menubarHdl = nil) then1329

ExitToShell;1330

SetMenuBar(menubarHdl);1331

DrawMenuBar;1332

1333

menuHdl := GetMenuHandle(mApple);1334

if (menuHdl = nil)1335

then ExitToShell1336

else AppendResMenu(menuHdl,'DRVR');1337

1338

{ ………………………………………………………………………………………………………………………………………………………………………………………… open window }1339

1340

gWindowPtr := GetNewWindow(rNewWindow, nil, WindowPtr(-1));1341

if (gWindowPtr = nil) then1342

ExitToShell;1343

1344

docRecHdl := DocRecHandle(NewHandle(sizeof(DocRec)));1345

if (docRecHdl = nil) then1346

ExitToShell;1347

1348

SetWRefCon(gWindowPtr, longint(docRecHdl));1349

1350

{ ……………………………………………………………………………………………………………………………………………………………………………… enter eventLoop }1351

1352

EventLoop;1353

1354

end.1355

1356

{ ###################################################################################### }1357

Demonstration Program Comments
When this program is run, the user should:

• Invoke alerts and dialog boxes by selecting items in the Demonstration menu, noting
window update/activation/deactivation and menu enabling/disabling effects.

• Note particularly the effects on the Apple, Help, and Application menus when alert,
modal, movable modal and modeless dialog boxes are the frontmost window.

• Click outside the alert box and modal dialog box when they are the frontmost window,
noting that the only response is the system alert sound.

• Note that, when the movable modal dialog box is displayed:

• The alert sound is played when the user clicks in both the window's content region
and its title bar.

• The program can be sent to the background by clicking outside the dialog box and
window or by selecting another application from the Application menu.

• The program can be brought to the foreground again by clicking inside the dialog
box or application window or by selecting the program from the Application menu.

• Note that, when the modeless dialog box is displayed:

• It behaves like a normal document window when the user:

• Clicks outside it (or selects another application from the Application menu)
when it is the frontmost window.

• Clicks inside it (or selects the application from the Application menu) when
it is not the frontmost window.

• It can be hidden by clicking in the close box or by selecting Close from the File
menu.

• An alert, modal dialog box or movable modal dialog box can be invoked "on top of"
the modeless dialog box.
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• The Edit menu Cut, Copy, Paste and Clear commands are enabled and support editing
in the editable text item.

• Note that the movable modal and modeless dialog boxes respond correctly to the Return,
Enter and Esc keys, and to the Command-period keyboard combination.

• Note that the 'ALRT' resource is defined to play the alert sound only at the first
invocation of the alert, display the alert box and play the alert sound once at the
second invocation, display the alert box and play the alert sound twice at the third
invocation, and display the alert box and play the alert sound three times at the fourth
and subsequent invocations.

• Note that, when the movable modal dialog and modeless dialog boxes are not the frontmost
window, the default button bold outline is dimmed.

• Select Show Balloons from the Help menu while an alert box or dialog box is the
frontmost window, cause balloons to open over the boxes and note the updating of the box
behind the balloon when the balloon closes.  Note that the system does not redraw the
icon or the bold outline of the default button of an alert box after it has been
obscured.

The constant declaration block

Lines 61-92 establish constants relating to menu and window resources, alert box and dialog
boxes resources and item numbers, menu IDs and menu item numbers.  Lines 94-95 establish
constants which will be assigned to the refCon field of the window records associated with the
movable modal dialog box and the modeless dialog box.  Lines 98-101 establish constants
representing the character codes for the Return, Enter, Esc, and period keys.

Line 102 defines kMaxLong as the maximum possible long value.  This value will be assigned to
WaitNextEvent's sleep parameter.

The type declaration block

At Lines 108-113, a data type for a document record is created.  The elements of the document
record will not actually be used in this demonstration.  The document record handle will
simply be assigned to the refCon field of the normal window’s window record.

The variable declaration block

gWindowPtr will be assigned the pointer to the single window opened by the program.
gSleepTime will be assigned the value which will be used as the sleep parameter in the
WaitNextEvent call.  (This value will be changed during program execution.)  gDone controls
the exit from the main event loop.  gInBackground relates to foreground/background switching.

The global variables at Lines 123-125 will contain the current setting of the checkboxes in
the modal dialog box.  The global variables at Lines 126-127 will contain the identity of the
newly selected and previously selected radio buttons in the movable modal dialog box.

Line 128 declares the pointer to the dialog record for the modeless dialog box as a global
variable because, when the dialog is invoked by the user, the program needs to know whether
the dialog has never been opened or whether it has previously been opened but is currently
hidden.

The procedure DoIdle

DoIdle is invoked whenever WaitNextEvent returns a null event.

Line 165 gets a pointer to the front window.  If the window is one of the dialog windows (Line
166), Line 168 retrieves the dialog type from the window record's refCon.  If the window is
the modeless dialog (which contains an editable text item), DialogSelect is called (Lines 170-
171).  DialogSelect, amongst other things, calls TEIdle, which blinks the insertion point
caret.  (As will be seen, WaitNextEvent's sleep parameter is changed from kMaxLong whenever
the modeless dialog box is the frontmost window, thus causing null events to be received at a
rate equal to the currently set caret blink rate.)

The procedure DoKeyDownMovableModal

DoKeyDownMovableModal continues key-down processing for key-downs in the movable modal dialog
box.

If the character code of the key equals the character code returned by the Return or Enter
keys (Line 252), the handle to the control record for the OK button control is obtained by the
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call to GetDialogItem (Line 254) and used at Lines 255-257 to highlight the OK button for 8
ticks.  The dialog box is then closed down (Line 258).

If the character code of the key equals the character code returned by the Esc key, or if the
Command and period keys were both down (Lines 261-262), the handle to the control record for
the Cancel button control is obtained by the call to GetDialogItem (Line 264) and used at
Lines 265-267 to highlight the Cancel button for 8 ticks.  Before the dialog box is closed
down (Line 269), and since the user has clicked the Cancel button, the value in the global
variable which keeps track of the currently selected radio button is made equal to the value
that was assigned to that variable before the dialog was invoked (Line 268).

The procedure DoItemHitModeless

DoItemHitModeless further processes, to completion, a mouse-down event in an enabled control
in the modeless dialog box.

Since the modeless dialog box has only one control (the Search (OK) button), the item hit must
have been that button.  Accordingly, Line 295 gets a handle to the editable text item, which
is used at Line 296 to retrieve the string in the editable text item.

The rest of the code is concerned only with printing the retrieved text string in the window.

The procedure DoKeyDownModeless

DoKeyDownModeless continues key-down processing for key-downs in the modeless dialog box.

This procedure performs the same button highlighting in response to Return and Enter key-downs
as did the previous procedure.  (The modeless dialog box has only one button — the Start (OK)
button.)  Note, however, that the dialog box is not dismissed after a Return or Enter key is
pressed.  Instead, the application-defined procedure DoItemHitModeless is called (Line 331).
As will be seen, that procedure extracts the text string from the editable text item.

If, however, the event did not arise from a Return or Enter key press (Line 334), the focus
changes to the editable text item.  Accordingly, at Line 336, DialogSelect is called to handle
the event automatically in conjunction with TextEdit, the visual result being the appearance
of the character in the editable text item display.

The procedure DoUpdateDocument

DoUpdateDocument simply fills the content region (less the scroll bar areas) of the window
with one of the system patterns to assist in visually "proving" correct window updating.

The procedure
DoUpdateMovableOrModeless

The update task for both movable modal and modeless dialog boxes is the same, that is, redraw
the update region.  Accordingly, the procedure DoUpdateMovableOrModeless calls UpdateDialog
between calls to BeginUpdate and EndUpdate (Lines 385-387) to achieve this.

The procedure DoActivateDocument

DoActivateDocument performs window activation for the document window.  If the window is
becoming active, the menus are adjusted as appropriate for a document window (Line 396-397).
Regardless of whether the window is being activated or deactivated, DrawGrowIcon is called
(Line 399).  (DrawGrowIcon "knows" whether the window is becoming active or inactive and draws
the grow icon or an empty size box accordingly.)

The procedure DrawDefaultButtonOutline

DrawDefaultButtonOutline is the application-defined function for drawing the bold outline
around the default button in the modal, movable modal and modeless dialog boxes.  Recall that,
in DoModalDialog, DoMovableModalDialog, and DoModelessDialog, a pointer to this draw function
was installed in the user item in the modal, movable modal, and modeless dialog boxes.  The
consequence of that is that this function will be called whenever the user item is part of the
dialog box's update region during a dialog box update.

Firstly, a pointer to the current graphics port is saved, as is the current pen state (Lines
423-424).

A handle to the OK button's control record, together with the button's display rectangle, is
retrieved at Line 426.  The handle is used at Line 427 to retrieve the pointer to the
control's owner window from the contrlOwner field of the control record.  The SetPort call at
Line 427 uses this window pointer to set the current graphics port.  The InsetRect call at
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Line 428 expands the returned rectangle by 4 pixels top and bottom and left and right, that
is, to the desired outside boundaries of the bold outline.

The next step is to determine whether the dialog box is using a colour graphics port.  The
following is relevant to this step:

• The seventh and eighth bytes in a colour graphics port constitute the portVersion field.
The two high bits of this word are invariably set.

• The seventh and eighth bytes in a non-colour graphics port constitute the rowBytes field
of the port's portBits field.  The high two bits of the rowBytes field are invariably
clear.

At Line 430, the window pointer in the contrlOwner field of the OK button's control record is
cast to a pointer to a colour graphics port so that the two top bits can be examined as if
they are part of the portVersion field of a colour graphics port.  (Of course, if we are
dealing with a non-colour graphics port, the bits will actually be the two top bits of the
rowBytes field.)  At Line 432, the bits are tested.  If the test indicates that the bits are
set, the port must be a colour graphics port, in which case the variable isColour is set to
true, otherwise it is set to false (Lines 433-434).

At Line 436, the variable which will control the curvature of the corners of the bold outline
is set to the appropriate value based on the vertical dimension of the OK box's display
rectangle.

The bold outline must be drawn in black if the OK button is active and in gray (that is,
either a gray colour or the gray pattern) if it is inactive.  Accordingly, Line 438 examines
the controlHilite field of the OK button's control record to determine whether the control is
currently inactive or active.

Lines 440-459 deal with the case of an inactive OK button.  Firstly, newGray is set to false
(Line 440) preparatory to possible modification in the next eight lines of code.

If the dialog is using a colour graphics port (Line 442), the current background and
foreground colours are assigned to two RGBColor variables (Lines 444-445) and the variable
newForeColour is made equal to the foreground colour (Line 446).  Line 447 retrieves a handle
to the main graphics device, that is, to the screen which carries the menu bar.  This handle
is required by the call to GetGray at Line 448.  GetGray provides the best available gray
between the two colours passed in the second and third parameters for the device specified in
the first parameter.  GetGray returns true if at least one gray or intermediate colour is
available, in which case the third parameter will contain that gray or intermediate colour.

If GetGray was successful, the colour returned is used to set the foreground drawing colour
(Line 452).  Otherwise, the current pen pattern is set to gray (Line 453).  (Note that gray is
a QuickDraw global variable specifying a pattern, not a colour.)

Having determined whether to draw the bold outline as a gray colour or as a gray pattern, the
next step is to draw the outline.  Accordingly, Lines 455-456 set the pen size and draw the
round-cornered rectangle with a call to FrameRoundRect.  It then remains to restore the
foreground colour to its previous value, if necessary (Lines 458-459).

If the test at Line 439 revealed that the OK button was active, Lines 463-465 simply set the
pen pattern to black and draw the round-cornered rectangle.

The function restores the old pen state and graphics port before returning (Lines 468-469).

The procedure DoActivateMovableModal

DoActivateMovableModal performs window activation and deactivation for the movable modal
dialog box.

If the dialog box is becoming active, a handle to each of the dialog's control records is
obtained with GetDialogItem, and HiliteControl is called to make the associated controls
active and undimmed (Lines 483-492).  In addition, an application-defined procedure which
draws the bold outline around the default button is called (Line 493) and the menus are
adjusted as appropriate for the movable modal dialog (Line 494).

If the dialog box is becoming inactive, the controls are made inactive and dimmed (497-505)
and the outline around the default button is drawn in gray (Line 506).

The procedure DoActivateModeless

DoActivateModeless performs window activation and deactivation for the modeless dialog box.
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If the dialog box is becoming active (Line 521), its control is made active and undimmed
(Lines 523-524), and the bold outline around the single button is drawn in black (Line 526).
The call to SelectDialogItemText at Line 527 causes the insertion point caret to blink (if
there is no text in the item) or the text to be selected (if there is text in the item).  Line
528 sets the variable used in the sleep parameter in the WaitNextEvent call to equal the value
returned by LMGetCaretTime (which is the value set by the user at the Insertion Point Blinking
section in the General Controls control panel).  Line 529 adjusts the menus as appropriate for
the modeless dialog box.

If the dialog box is becoming inactive (Line 532), its control is made inactive and dimmed
(Lines 533-534), the bold outline around the default button is drawn in gray (Line 536),
selected text is de-selected (Line 537) and the variable used in the sleep parameter of the
WaitNextEvent call is reset to kMaxLong (Line 538).

The procedure DoActivate

DoActivate performs initial processing of activate events.  If the window is a dialog window
(Line 556), and if it is either the movable modal or modeless dialog, the appropriate
application-defined activation procedure is called (Lines 560-563).  However, if the window is
the normal window, the application-defined procedure DoActivateDocument is called (Lines 566-
567).

The procedure DoOSEvent

DoOSEvent handles operating system events, branching according to whether the event is a
suspend/resume event or a mouse-moved event (Line 583).  If the event is a suspend/resume
event (Line 585), DoOSEvent calls the appropriate window activation procedure depending on
whether the window is the movable modal dialog, the modeless dialog, or the normal window
(Lines 589-600), indicating to that function whether to activate or deactivate the window.

The procedure DoUpdate

DoUpdate performs initial processing of update events.  If the window is one of the dialog
windows (Line 623), and if it is either the movable modal or modeless dialog (Line 627), the
application-defined procedure DoUpdateMovableOrModeless is called (Line 628).  If, however,
the window is the normal window, the application-defined procedure DoUpdateDocument is called
(Lines 631-632).

The procedure DoHideModeless

DoHideModeless hides the modeless dialog box.  Line 646 gets a pointer to the front window.
If the front window is a dialog (Line 648), and if it is the modeless dialog (Lines 652),
HideWindow is called at Line 654 to deactivate the dialog box, make it invisible, and activate
the window immediately behind.  In addition, and since caret blinking in the editable text
item is no longer required, the variable which determines the sleep parameter in the
WaitNextEvent call is set back to kMaxLong (Line 656).

The InvalRgn call at Line 655 is included simply to force a redraw of the window, thus erasing
the text string drawn in the window if the dialog's Search (OK) button was clicked during
execution of the DoItemHitModeless function.

The procedure DoEditMenu

DoEditMenu first determines whether the front window is the modeless dialog (Lines 671-673).
In this program, the Edit menu is only enabled when the modeless dialog box is the frontmost
window.  Accordingly, if the front window is the modeless dialog, Cut, Copy, Paste, and Clear
selections from the Edit menu will cause the appropriate TextEdit routines to be called to
perform those operations on selected text in the editable text item  (LInes 677-699).

The function EventFilter

EventFilter is the application-defined event filter function which, in conjuction with
ModalDialog, handles events in the alert box and the modal dialog box.  In this program, a
ProcPtr to EventFilter is passed as the first parameter in the NoteAlert and ModalDialog
calls.  Note that EventFilter's fourth parameter is a variable parameter.

The application-defined event filter function is necessary to compensate for certain
inadequacies of the standard event filter function.  It is required to return true if it
handled the event or false if it wants the Dialog Manager to process the event.  Line 719 sets
the variable which will be used to return true or false to ModalDialog and NoteAlert to an
initial value of false.
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If the event is an update event not belonging to the alert box or modal dialog box (Line 721),
the application-defined function DoUpdate is called to update the window specified in the
message field of the event record (Line 722).  In this program, that window could be either
the window or the modeless dialog box.  Note also that, by responding to update events in your
own inactive windows in this way, you allow ModalDialog to perform a minor switch when
necessay so that background applications can update their windows as well.  (It may be of
interest to remove the DoUpdate call and observe the effect of Help balloons on the
application's window and on windows belonging to other applications.)

If the event is a key-down or autokey event (Line 726), and if the character code is that for
the Return key or the Enter key (Line 729), Lines 731-736 highlight the OK button for eight
ticks, assign true to the variable which contains the function's return value, and assign the
item number of the OK button to the itemHit variable.  (The value in this variable will be
returned by ModalDialog.)

If the event is a key-down or autokey event (Line 726), and if the character code and an
examination of the event record modifiers field indicates that either the Esc key or the
Command-period combination was pressed (Lines 738-739), Lines 740-746 highlight the Cancel
button for eight ticks, assign true to the variable which contains the function's return value
and assigns the item number of the Cancel button to the itemHit variable.  (The value in this
variable will be returned by ModalDialog.)

At Line 757, true is returned if the event was a key-down or autokey event related to the OK
or Cancel buttons, causing ModalDialog to ignore these events.  Otherwise false is returned,
indicating that ModalDialog should process the event itself.  (The effect of returning false
from this event filter in this program is that ModalDialog will handle all mouse events in the
alert box or modal dialog box and all update events related to the alert or dialog box only.)

The function DoModalDialog

DoModalDialog creates, manages and disposes of the modal dialog.

At Line 773, the call to GetNewDialog creates the dialog from the specified resource as the
frontmost window.

The GetDialogItem call (Line 780) specifies this dialog's user item number at the second
parameter and will thus return, in the fourth parameter, the address at which to install the
pointer to the application-defined draw function for drawing the bold outline around the
default button.  (The user item display rectangle overlays the default button display
rectangle.)  The SetDialogItem call at Line 781 installs the draw function.

Lines 783-790 obtain handles to the three checkbox controls for the purposes of setting the
value of these controls to the values contained in the global variables relating to each
control.  With the dialog fully prepared, it is made visible by the call to ShowWindow at Line
792.

The repeat/until loop at Lines 794-802 continues to call ModalDialog until the itemHit
variable signifies that the OK or Cancel button has been "hit".  Note that the first parameter
in the ModalDialog call is a pointer to the application-defined event filter function.  The
second parameter receives the item number of the "hit" item.  ModalDialog retains control
until one of the checkboxes or one of the buttons is "hit".  If a checkbox is clicked, the
handle to the item is retrieved for the purposes of flipping the relevant checkbox's value
(Lines 797-800) and the loop continues.

When the loop exits, and if the user "hit" the OK button (Line 804), handles to each of the
three checkboxes are retrieved for the purposes of retrieving the control's value and
assigning it to the relevant global variable.  (If the user "hit" the Cancel button, the
global variables retain the values they contained before the dialog was displayed.)
The dialog is then disposed of (Line 816).

The function DoMovableModalDialog

DoMovableModalDialog creates the movable modal dialog.

The call to GetNewDialog at Line 833 creates the dialog and the call to SetWRefCon at Line 841
assigns the constant kMovableModal to the refCon field of the window record associated with
the dialog.  The application-defined function for drawing the bold outline around the default
button is installed at Lines 843-845.

At Lines 847-848, the current radio button item number stored in the global variable
gBrushType is used to retrieve a handle to the item, which is then used in the SetControlValue
call to set that particular button.  With the dialog fully prepared, the call to ShowWindow at
Line 850 displays the dialog.
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User interaction is handled by the main event loop.  Before that interaction begins, the
current value in gBrushType is assigned to the global variable gOldBrushType (Line 852).  As
will be seen, this value will be re-assigned to gBrushType if the user "hits" the dialog's
Cancel button.

The function DoModelessDialog

In this program, the modeless dialog is only created once, that is, when the user first
selects Modeless… from the Demonstration menu.  Clicks in its close box, or selecting Close
from the File menu while the modeless dialog is the frontmost window, will cause the dialog
box to be hidden, not disposed of.

Accordingly, Line 868 of the DoModelessDialog function first determines whether the modeless
dialog box is already open.  If it is not, Line 870 creates the modeless dialog, the call to
SetWRefCon at Line 877 assigns the constant kModeless to the refCon field of the window record
associated with the dialog, Lines 879-881 install the application-defined function for drawing
the bold outline around the default button, Line 883 displays the window, and the call to
SeIectDialogItemText at Line 884 selects the text in the editable text item item (item
contains text) or displays the insertion point (item does not contain text).

If the modeless dialog box has already been opened (Line 887), Lines 888-889 show the hidden
dialog box and call SelectWindow to generate the necessary activate events.

User interaction with the modeless dialog box is handled by the main event loop.

The procedure DoDemonstrationMenu

doDemonstrationMenu handles selections from the Demonstration menu, switching according to the
menu item passed to it.

If the user chose Alert (Line 908), NoteAlert is called (Line 928).  Before calling NoteAlert,
however, an application must explicitly deactivate the front document window, if one exists.
(In this demonstration, the only document window deactivation action required is to erase the
grow icon.)  In addition, if a modeless dialog is open and showing, that dialog must also be
deactivated.

The 'ALRT' resource specifies that, at the first invocation of the alert, the alert sound is
to be played but the alert box itself is not to be displayed.  Accordingly, Line 910 ensures
that Lines 911-927 will only execute if this is not the first invocation.

If there is at least one window of any type open, and if the front window is not the modeless
dialog window (Lines 912-914),  Lines 916-919 invalidate the grow icon area so as to force an
update event for the window.  Line 920 then, in effect, calls DrawGrowIcon to erase the grow
box.  If, however, there is at least one window of any type open and the front window is the
modeless dialog (Line 922), the modeless dialog is deactivated (Line 924).

NoteAlert is called at Line 928.  Note that this program uses an application-defined filter
function, the address of which is passed as the second parameter in the NoteAlert call.
NoteAlert exits when the user clicks one of the buttons or presses the Return, Enter, Esc, or
Command-period keys.

If the user chose Modal… (Line 931), the same general procedure is followed except that the
call to GetAlrtStage is not made and the the application-defined function for creating,
managing and disposing of the modal dialog is called (Lines 932-953).  (As will be seen, the
application-defined filter function is also used to handle events in the modal dialog box.)

If the user chose Movable Modal…, the application-defined function for creating the movable
modal dialog is called (Lines 956-962).  (From then on, all events pertaining to the movable
modal dialog are handled in the main event loop.)

If the user chose Modeless…, the application-defined function for creating the modeless dialog
is called (Lines 964-970).  (From then on, all events pertaining to the modeless dialog are
handled in the main event loop.)

The procedure DoMenuChoice

DoMenuChoice extracts the menu ID and item ID from the long value passed to it (Lines 987-988)
and branches according to the menu ID (provided that the menuID value is not 0, meaning that
no item was selected).

If the choice was the Quit item in the File menu menu, gDone is set to true, thus terminating
the program (Lines 1007-1008).  If the choice was the Close item in the File menu, an
application-defined procedure which hides the modeless dialog box is called (Lines 1009-1010).
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(In this program, the Close item is only enabled when the modeless dialog box is the front
window.)

The procedure DoKeyDownDocument

DoKeyDownDocument continues key-down processing for key-downs in the window.  The character
code for the key is extracted from the event record (Line 1037).  If the Command key was down
at the same time (Line 1039), the menus are adjusted and the results of a call to MenuKey are
passed to the application-defined function DoMenuChoice (Lines 1040-1043).

The procedure DoKeyDown

DoKeyDown takes the key-down and auto-key events and switches according to the type of window
in which the event occurred.

The procedure DoItemHitMovableModal

DoItemHitMovableModal further processes, to completion, a mouse-down event in an enabled
control in the movable modal dialog box.

Line 1093 determines whether the mouse-down was in one of the three radio buttons.  If so,
Lines 1094-1109 reset the control value of all three radio buttons to 0 and Lines 1101-1102
set the control value of the radio button that was clicked to 1.  In addition, the global
variable which holds the currently set radio button is assigned the item number of the radio
button that was clicked (Line 1103).

If the radio buttons were not clicked, Lines 1106-1113 cover the remaining possibilities, that
is, a click in either the OK button or the Cancel button.  If the Cancel button was clicked,
the global variable gBrushType is assigned the value it contained before the session of user
interaction with the dialog began (Lines 1109-1110).  If either the OK or the Cancel button
was clicked, the dialog box is disposed of (Line 1111).

The procedure InvalidateScrollBarAreas

InvalidateScrollBarAreas invalidates the scroll bar areas of the window as part of the usual
window management procedures.

The procedure DoInContent

DoInContent continues the content region mouse-down handling initiated by DoMouseDown.
DoInContent is called by DoMouseDown only if the mouse-down occured in the frontmost (active)
window.

Line 1148 gets a pointer to the frontmost window.

If the frontmost window is a dialog (Line 1150), and if it is the movable modal dialog box
(Lines 1152-1154), DialogSelect is called (Line 1156).  DialogSelect returns true if the
mouse-down occurs in an enabled item, in which case the third parameter contains the item
number involved.  Thus, if the mouse-down occurred in an enabled item, the application-defined
function DoItemHitMovableModal is called (Line 1157) to further process the mouse-down event.
(Note that DialogSelect tracks user action after the mouse-button goes down and returns true
only if the cursor is still within the control when the mouse button is released.)

If the frontmost window is the modeless dialog box (LIne 1160) and the mouse-down occurred in
an enabled item, the application-defined function DoItemHitModeless is called to further
process the mouse-down event.

The procedure DoMouseDown

DoMouseDown handles mouse-down events.  Mouse-downs in the content region, in the title bar,
and in the close box are of significance to the demonstration.

In the event of a mouse-down in the content region (Line 1200), Line 1202 establishes whether
the click was in the frontmost window or another window.  If the click was not in the
frontmost window, and if the front window is the movable modal dialog box, the system alert
sound is played (Lines 1204-1205) and the dialog box is retained as the frontmost window.
(This action is necessary to preserve the required modal characteristic of movable modal
dialog boxes.)  If the front window was not the movable modal dialog box, SelectWindow is
called (Line 1206) to generate the necessary activate events.

If the mouse-down was in the frontmost window, the application-defined function DoInContent is
called to further process the event (Line 1209).
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A movable modal dialog box must also remain the frontmost window if the user clicks in the
title bar of the application's window.  Accordingly, before DragWindow is called to handle a
title bar mouse-down (Line 1220),  Line 1214 checks to see if the front window is the movable
modal dialog box.  If it is, and if the event relates to another window (Line 1215), the
system alert sound is played and the function returns without calling DragWindow (1217-1218).

If a mouse-down occurs in the close box, and if TrackGoAway returns true (Lines 1223-1225),
the application-defined function DoHideModeless is called.  (In this demonstration, the
modeless dialog box, but not the window, has a close box.)

Lines 1229-1240 provide the usual responses for a mouse-down in the size box of the window.

The procedure DoEvents

DoEvents switches according to the event type reported.  (It is important to remember at this
point that events which occur when an alert box or modal dialog box has been invoked are not
handled by the main event loop and associated event-handling functions.)

The procedure EventLoop

The main event loop continues until gDone is set to true by the user selecting Quit from the
File menu.

At Line 1294, the variable which will be used as WaitNextEvent's sleep parameter is set to
kMaxLong, indicating that the application has no need for null events and that it will yield
the microprocessor to other applications for the maximum possible time if no events are
pending for it.  Note that the value assigned to gSleepTime will be changed later on, causing
null events to be received; hence the call to the idle processing function at Line 1304.

The main program block

The main function initialises the system software managers (Line 1323), sets up the menu bar
and menus (Lines 1327-1336), opens a window (Line 1340), creates a relocatable block for the
window's window record and assigns the handle to the window record's refCon field (1344-1348),
and enters the main event loop (Line 1352).

Note that error handling here and in other areas of the program is somewhat rudimentary.  The
program simply terminates.

AN ALTERNATIVE APPROACH FOR THE MODAL DIALOG

The following details an alternative approach to achieving keystroke aliasing for the OK and
Cancel buttons, and default button outlining, in the modal dialog.  This approach involves the
use of two Dialog Manager routines (SetDialogDefaultItem and SetDialogCancelItem) for which
documentation remains somewhat obscure.

SetDialogTracksCursor is a sister routine introduced with SetDialogDefaultItem and
SetDialogCancelItem.  If a modal dialog includes one or more editable text items, this routine
may be used to automatically change the cursor to the I-beam shape whenever it is over an
editable text item.  The following also includes a demonstration of the use of this sister
routine.

Step 1 is to open the modal dialog’s 'DITL' resource, remove the User Item and add an editable
text item, taking care not to change the item numbers of the OK and Cancel buttons.  (Note
that, when the Dialog Manager "sees" the editable text it the item list, it will automatically
activate and deactivate the Edit menu and the Cut, Copy, and Paste items when the dialog is
opened and closed.)

Step 2 is to replace the DoModalDialog function with the following version:

function DoModalDialog : boolean;

var
modalDlgPtr : DialogPtr;
itemType, itemHit : integer;
itemHdl : Handle;
itemRect : Rect;
osError : OSErr;

begin
modalDlgPtr := GetNewDialog(rModal, nil, WindowPtr(-1));
if(modalDlgPtr = nil) then
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begin
DoModalDialog := false;
Exit(DoModalDialog);
end;

{ Installation of DrawDefaultButtonOutline function removed from here. }

GetDialogItem(modalDlgPtr, iGridSnap, itemType, itemHdl, itemRect);
SetControlValue(ControlHandle(itemHdl), gGridSnap);

GetDialogItem(modalDlgPtr, iShowGrid, itemType, itemHdl, itemRect);
SetControlValue(ControlHandle(itemHdl), gShowGrid);

GetDialogItem(modalDlgPtr, iShowRulers, itemType, itemHdl, itemRect);
SetControlValue(ControlHandle(itemHdl), gShowRule);

{ SetDialogDefaultItem will enable automatic keyboard aliasing for the OK button and
  will also cause a bold outline to be drawn around that button.  SetDialogCancelItem
  will enable automatic keyboard aliasing for the Cancel button.
  SetDialogTracksCursor will enable automatic cursor tracking, causing the cursor to
  change to the I-beam shape when it is over the editable text item. }

osError := SetDialogDefaultItem(modalDlgPtr, iOK);
osError := SetDialogCancelItem(modalDlgPtr, iCancel);
osError := SetDialogTracksCursor(modalDlgPtr, true);

ShowWindow(modalDlgPtr);

{ Specify new event filter for modal dialog in first parameter of ModalDialog call. }

repeat

ModalDialog(ModalFilterUPP(@eventFilterModal), itemHit);
GetDialogItem(modalDlgPtr, itemHit, itemType, itemHdl, itemRect);
SetControlValue(ControlHandle(itemHdl), not(GetControlValue(ControlHandle(itemHdl))));

 until ((itemHit = iOK) or (itemHit = iCancel));

if (itemHit = iOK) then
begin
GetDialogItem(modalDlgPtr, iGridSnap, itemType, itemHdl, itemRect);
gGridSnap := GetControlValue(ControlHandle(itemHdl));

GetDialogItem(modalDlgPtr, iShowGrid, itemType, itemHdl, itemRect);
gShowGrid := GetControlValue(ControlHandle(itemHdl));

GetDialogItem(modalDlgPtr, iShowRulers, itemType, itemHdl, itemRect);
gShowRule := GetControlValue(ControlHandle(itemHdl));
end;

DisposeDialog(modalDlgPtr);

DoModalDialog := true;
end;

{of function DoModalDialog}

Step 3 is to add this new application-defined filter function for use by the modal dialog:

function EventFilterModal(theDialogPtr : DialogPtr; theEvent : EventRecord;
 var itemHit : integer) : boolean;

var
handledEvent : integer;
osError : OSErr;
standardProc : ModalFilterUPP;
oldPort : GrafPtr;

begin
handledEvent := false;

if ((theEvent.what = updateEvt) and (WindowPtr(theEvent .message) <> theDialogPtr)) then
begin
DoUpdate(theEvent);
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end
else begin

GetPort(oldPort);
SetPort(theDialogPtr);

{ In order for the SetDialogDefaultItem, SetDialogCancelItem, and
  SetDialogTracksCursor calls to work, you must call the standard filter procedure.}

osError := GetStdFilterProc(standardProc);
if not (osError) then

handledEvent = ModalFilterUPP(standardProc) (theDialogPtr, theEvent, itemHit);

SetPort(oldPort);
end;

if (handledEvent <> 0) then
EventFilterModal := true

else EventFilterModal := false;

end;
{of function EventFilterModal}

Creating 'ALRT' , 'DLOG' , and 'DITL'  Resources Using ResEdit

When learning to create the major resource types in ResEdit, it is recommended that you open
Macintosh C to the page containing the relevant example resource definition in Rez input format and
relate what you are doing within ResEdit to that definition.  Accordingly, the methodology used in the
following is to "walk through" selected 'ALRT', 'DLOG', and 'DITL' resources for the DialogsAndAlerts
demonstration program, relating what you see in ResEdit to the example definitions in this chapter.

Open the chap06pascal_demo demonstration program folder and double-click on the
DialogsAndAlerts.µ.rsrc icon to start ResEdit and open DialogsAndAlerts.µ.rsrc.

The DialogsAndAlerts.µ.rsrc window opens.

'ALRT'  Resource

Double-click the ALRT icon.  The ALRTs from DialogsAndAlerts.µ.rsrc  window opens.  Double-click the
list entry for ID = 128.  The ALRT ID = 128 from DialogsAndAlerts.µ.rsrc window opens.

The following relates the example 'ALRT' resource in Rez input format in this chapter to the ResEdit
display and interface:

resource 'ALRT' This was established when the resource was created by choosing
Resource/Create New Resource.  A small dialog opened, the item ALRT was
clicked, and the dialog's OK button was clicked.

(kSaveAlertID, kSaveAlertID is the 'ALRT' resource ID (128).  Choose Resource/Get Resource
Info.  The Info for ALRT 128 ... window opens.  Note the editable text item titled
ID:.  This is where you set the 'ALRT' resource ID.  (ResEdit automatically
assigns 128 as the 'ALRT' resource ID of the first 'ALRT' resource you create.)

purgeable) While the Info for ALRT 128 ... window is open, compare the Attributes: check
boxes to the Resource Attributes table at Chapter 1.  Note that the Purgeable
checkbox is checked.  Close the Info for ALRT 128 ... window.

{94,80,183,438} In the ALRT ID = 128 ... window, note the Top, Left, Bottom, and Right items at
the bottom left.  (Also note that, in the ALRT menu, you can change the last two
items to display Height and Width if you so desire.)

kAlertItemList The resource ID for the item list ('DITL') resource (128).  Note the DITL ID: item
at the right of the window.
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 OK,visible,sound1,
 OK,visible,sound1,
 OK,visible,sound1,
 OK,visible,sound1,

4th, 3rd, 2nd, and 1st alert stages.  Choose ALRT/Set'ALRT' Stage Info… and note,
in turn:

• the Default button/OK/Cancel checkboxes,

• the Alert box/Visible checkboxes, and

• the Sounds clickable items,

against the four stages.

alertPosition... Choose ALRT/Auto Position... and note the items chosen in the two pop-up
menus.

You might also further explore the ResEdit display options by choosing ALRT/Preview at Full Size , and
the various items in the MiniScreen menu.

Note that, when you click on the Color: Custom radio button at the right of the ALRT ID = 128 ...
window, five items appear which enable you to specify colours for the various elements of the alert
window.  If you were to save the resource with this radio button set, ResEdit would automatically
create a 'actb'  (alert color table) resource with the same resource ID as the associated 'ALRT' resource.

Close the ALRT ID = 128 ... window.  Close the  ALRTs from DialogsAndAlerts.µ.rsrc window.

'DLOG'  Resources

Double-click the DLOG icon.  The DLOGs from DialogsAndAlerts.µ.rsrc window opens.  Several 'DLOG'
resources (IDs 129 to 131) appear in the list.  These are, in sequence, the 'DLOG' resources for:

• The modal dialog (ID 129).

• The movable modal dialog (ID 130).

• The modeless dialog (IDs 131).

Double-click the entry for the modal dialog (ID 129).  The DLOG ID = 129 from DialogsAndAlerts.µ.rsrc
window opens.

The following relates the example 'DLOG' resource in Rez input format in this chapter to the ResEdit
display and interface:

resource 'DLOG' This was established when the resource was created by choosing
Resource/Create New Resource.  A small dialog opened, the item DLOG was
clicked, and the dialog's OK button was clicked.

(kSpellCheckID, kSpellCheckID is the 'DLOG' resource ID (129).  Choose Resource/Get Resource
Info.  The Info for DLOG 129 ...  window opens.  Note the editable text item
titled ID:.  This is where you set the 'DLOG' resource ID.  (ResEdit automatically
assigns 128 as the 'DLOG' resource ID of the first 'DLOG' resource you create.)

purgeable) While the Info for DLOG 129 ...  window is open, compare the Attributes: check
boxes to the Resource Attributes table at Chapter 1.  Note that the Purgeable
checkbox is checked.  Close the Info for DLOG 129 ... window.

{62,184,216,448}, In the DLOG ID = 129 ... window, note the Top, Left, Bottom, and Right items at
the bottom left.  (Note also that, in the DLOG menu, you can change the last two
items to display Height and Width if you so desire.)

dBoxProc, Note that, in the row of window icons at the top of the window, the dBoxProc (1)
window type is highlighted.  Note also that, when you choose DLOG/Set 'DLOG'
Characteristics..., the ProcID: item in the opened dialog box shows 1.  (You can
set the desired Window Definition ID either here or by clicking the appropriate
icon at the top of the window.)  Close the dialog.
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invisible, Back in the DLOG ID = 128 ... window, note the  check box titled Initially Visible
at the right.

noGoAway, Note the check box titled Close Box at the right.

kSpellCheckDITL..., Note the editable text item DITL ID: at the right of the window.  This is where
you enter the ID of the 'DITL' resource to be associated with this dialog.

"SpellCheck Op...", Choose DLOG/Set 'DLOG' Characteristics....  Note the editable text item Window
title:.  Close the dialog.

staggerParent... Choose DLOG/Auto Position... and note the items chosen in the two pop-up
menus.

You might also further explore the ResEdit display options by choosing DLOG/Preview at Full Size, and
the various items in the MiniScreen menu.

Note that, when you click on the Color: Custom radio button at the right of the DLOG ID = 129 ...
window, five items appear which enable you to specify colours for the various elements of the window.
If you were to save the resource with this radio button set, ResEdit would automatically create a 'dctb'
(dialog color table) resource with the same resource ID as the associated 'DLOG' resource.

Close the DLOG ID = 128 ... window.  Close the DLOGs from DialogsAndAlerts.µ.rsrc window.

'DITL'  Resources

Double-click the DITL icon.  The DITLs from DialogsAndAlerts.µ.rsrc window opens.  Several 'DITL'
resources (IDs 128 to 131) appear in the list.  These are, in sequence, the 'DITL' resources for:

• The alert (ID 128).

• The modal dialog (ID 129).

• The movable modal dialog (ID 130).

• The modeless dialog (IDs 131).

Double-click the entry for the modeless dialog (ID 131).  The DITL ID = 131 from
DialogsAndAlerts.µ.rsrc window opens.

The following relates the example 'DITL' resource in Rez input format in this chapter to the ResEdit
display and interface:

resource 'DITL' This was established when the resource was created by choosing
Resource/Create New Resource.  A small dialog opened, the item DITL was
clicked, and the dialog's OK button was clicked.

(kAboutBoxDITL, kAboutBoxDITL is the 'DITL' resource ID (131).  Choose Resource/Get Resource
Info.  The Info for DITL 131 ...  window opens.  Note the editable text item titled
ID:.  This is where you set the 'DITL' resource ID.  (ResEdit automatically
assigns 128 as the 'DITL' resource ID of the first 'DITL' resource you create.)

purgeable) While the Info for DITL 131 ...  window is open, compare the Attributes: check
boxes to the Resource Attributes table at Chapter 1.  Note that the Purgeable
checkbox is checked.  Close the Info for DITL 131 ... window.

{86,201,106,259}, The display rectangle.  In the DITL ID = 131 from DialogsAndAlerts.µ.rsrc
window, drag item #3 out of the way to fully reveal item #1.  (Item #1 was
created by dragging a button icon from the item palette roughly into position in
the window.)  Double click on item #1.  The Edit DITL item #1 ... window opens.
Note the Top, Left, Bottom, and Right items.  (Also note that, in the Item menu,
you can change the latter two items to display Height and Width if you so
desire.)
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Button  { This was established by the icon dragged into the  DITL ID = 131 from
DialogsAndAlerts.µ.rsrc window from the item palette.  (However, note that, in
the popup menu at the left, the item type can be changed.)

  enabled. Note the Enabled checkbox at lower left.

  "OK"  }, Note the editable text item Text.  Close the Edit DITL item #1 ... window.

{10,20,42,52}, In this case, the Icon item from the item palette was dragged roughly into
position in the window .  Double-click item #2 to open the Edit DITL item #2 ...
window.  Note the Top, Left, Height, and Width values.

Icon    { This was established by the Icon icon dragged into the DITL ID = 131 from
DialogsAndAlerts.µ.rsrc window from the item palette.

  disabled, Note the Enabled checkbox at lower left.

  kAboutIconID  }, Note the Resource ID item.  Close the Edit DITL item #1 ... window.  Close the
DITL ID = 131 from DialogsAndAlerts.µ.rsrc window.

Close the DITLs from DialogsAndAlerts.µ.rsrc window.  Close the DialogsAndAlerts.µ.rsrc window
without saving.


